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2018 Spine Surgery:
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Preface
Dear Data Submitters,
Attached is our 2018 Spine Surgery: Lumbar Discectomy/Laminotomy Data Collection Guide. We greatly
appreciate your medical group or clinic contributing data on quality, patient outcomes and patient
experience. We know your contribution is vital to MN Community Measurement’s ability to achieve our
mission to accelerate the improvement of health by publicly reporting health care information.
We value your involvement and want to support your success as well. We provide resources, tools and
reports that your medical group or clinic can use for quality improvement.
The following resources can be found on our corporate website, MNCM.org:
•
•
•
•
•
•

Public reports including the Health Care Quality Report, Heath Equity of Care Report, Health
Care Disparities Report and Total Cost of Care Report
Patient education and engagement resources
Provider tools and resources
Monthly Q & A session details
Educational webinars throughout the year
Health Trackers

Additionally, these resources can be found on the secure MNCM Data Portal:
•
•
•

Detailed reports and charts of clinical measure results
Charts of specific clinical measure results segmented by race, Hispanic ethnicity, preferred
language and country of origin (REL) for medical groups following best practices
Patient Experience of Care Survey results at the domain and question-level

Finally, on MNHealthScores.org, you can see public-facing results of all of our measures for clinics,
medical groups or hospitals. As this is our consumer-focused site, it has less detail than is available in our
reports and on the Data Portal.
MNCM is committed to working with our multi-stakeholder committees to champion the highest value
measures that will make the most impact in our community, while balancing burden on organizations
that supply the data. As performance improves, we have processes in place to ensure the appropriate
retirement of measures to minimize burden.
Thank you again for your important role in our work. If you have questions, feel free to contact us at
612-746-4522 or support@mncm.org.

Anne Snowden, MPH, CPHQ
Director, Performance Measurement, Validation & Reporting
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Summary of Changes
A. Measure Specification Changes from Previous Year
1. Clarification of Procedure, Preop Assessment, and Postop Assessment Periods.
See Measure Specifications for further detail.

B. Field Specification Changes from Previous Year
1. Change of Tobacco Status (Column V) to optional field.
See Data Elements and Field Specifications table for further detail.

C. Other Changes from Previous Year

1. Addition of Appendix F: Additional Measures.

D. Changes from Draft to Final
NONE
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Measure Specifications
Summary of Changes

Clarification of Procedure, Preop Assessment, and Postop Assessment
Periods.

Measure

Lumbar Discectomy Laminotomy: Average change in functional status

Description

The average change (preoperative to three months post-operative) in
functional status for patients 18 years of age or older who had a lumbar
discectomy laminotomy procedure

Measurement Period

Procedure Period: January 1 through December 31, 2016
Preop Assessment Period: October 1, 2015 through December 31, 2016
Postop Assessment Period: February 12, 2016 through May 20, 2017

Eligible Population

Eligible Specialties

Orthopedic Surgery, Neurosurgery

Eligible Providers

Medical Doctor (MD), Doctor of Osteopathy (DO)

Ages

18 years or older at the start of the procedure period

Event

Lumbar discectomy laminotomy procedure (Single
Disc-Lami Value Set) for a diagnosis of disc herniation
(Disc Herniation Value Set) performed by an eligible
provider in an eligible specialty during the procedure
period

Denominator

Patients within the eligible population whose functional status was
measured by the Oswestry Disability Index, version 2.1a (ODI, v2.1a) within
three months preoperatively AND at three months (6 to 20 weeks)
postoperatively

Numerator

The average change (preoperative to three months post-operative) in
functional status for all patients in the denominator

Required Exclusions

The following exclusions must be applied to the eligible population:
• Patient had any additional spine procedures performed on the same date
as the lumbar discectomy laminotomy

Measure Scoring

Number

Interpretation of Score

Higher score indicates better quality

Measure Type

Outcome

Helpline: 612-746-4522 | E-mail: support@mncm.org | MNCM Data Portal: https://data.mncm.org/login
© MN Community Measurement, 2017. All rights reserved.
iii

2018 Spine Surgery:
Lumbar Discectomy/Laminotomy
Measure Specifications
Measure

Lumbar Discectomy Laminotomy: Average change in health related quality
of life

Description

The average change (preoperative to three months post-operative) in health
related quality of life for patients 18 years of age or older who had lumbar
discectomy laminotomy procedure

Measurement Period

Procedure Period: January 1 through December 31, 2016
Preop Assessment Period: October 1, 2015 through December 31, 2016
Postop Assessment Period: February 12, 2016 through May 20, 2017

Eligible Population

Eligible Specialties

Orthopedic Surgery, Neurosurgery

Eligible Providers

Medical Doctor (MD), Doctor of Osteopathy (DO)

Ages

18 years or older at the start of the procedure period

Event

Lumbar discectomy laminotomy procedure (Single
Disc-Lami Value Set) for a diagnosis of disc herniation
(Disc Herniation Value Set) performed by an eligible
provider in an eligible specialty during the procedure
period

Denominator

Patients within the eligible population whose health related quality of life
was measured by the PROMIS-10 within three months preoperatively AND
at three months (6 to 20 weeks) postoperatively

Numerator

The average change (preoperative to three months post-operative) in health
related quality of life for all patients in the denominator

Required Exclusions

The following exclusions must be applied to the eligible population:
• Patient had any additional spine procedures performed on the same date
as the lumbar discectomy laminotomy

Measure Scoring

Number
Results are reported by:
• Average change in health related quality of life- physical health
• Average change in health related quality of life- mental health

Interpretation of Score

Higher score indicates better quality

Measure Type

Outcome
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Measure

Lumbar Discectomy Laminotomy: Average change in back pain

Description

The average change (preoperative to three months post-operative) in back
pain for patients 18 years of age or older who had lumbar discectomy
laminotomy procedure

Measurement Period

Procedure Period: January 1 through December 31, 2016
Preop Assessment Period: October 1, 2015 through December 31, 2016
Postop Assessment Period: February 12, 2016 through May 20, 2017

Eligible Population

Eligible Specialties

Orthopedic Surgery, Neurosurgery

Eligible Providers

Medical Doctor (MD), Doctor of Osteopathy (DO)

Ages

18 years or older at the start of the procedure period

Event

Lumbar discectomy laminotomy procedure (Single
Disc-Lami Value Set) for a diagnosis of disc herniation
(Disc Herniation Value Set) performed by an eligible
provider in an eligible specialty during the procedure
period

Denominator

Patients within the eligible population whose back pain was measured by
the Visual Analog Scale (VAS) within three months preoperatively AND at
three months (6 to 20 weeks) postoperatively

Numerator

The average change (preoperative to three months post-operative) in back
pain for all patients in the denominator

Required Exclusions

The following exclusions must be applied to the eligible population:
•

Patient had any additional spine procedures performed on the same
date as the lumbar discectomy laminotomy

Measure Scoring

Number

Interpretation of Score

Higher score indicates better quality

Measure Type

Outcome
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Measure

Lumbar Discectomy Laminotomy: Average change in leg pain

Description

The average change (preoperative to three months post-operative) in leg
pain for patients 18 years of age or older who had lumbar discectomy
laminotomy procedure

Measurement Period

Procedure Period: January 1 through December 31, 2016
Preop Assessment Period: October 1, 2015 through December 31, 2016
Postop Assessment Period: February 12, 2016 through May 20, 2017

Eligible Population

Eligible Specialties

Orthopedic Surgery, Neurosurgery

Eligible Providers

Medical Doctor (MD), Doctor of Osteopathy (DO)

Ages
Event

18 years or older at the start of the procedure period
Lumbar discectomy laminotomy procedure (Single
Disc-Lami Value Set) for a diagnosis of disc herniation
(Disc Herniation Value Set) performed by an eligible
provider in an eligible specialty during the procedure
period

Denominator

Patients within the eligible population whose leg pain was measured by the
Visual Analog Scale (VAS) within three months preoperatively AND at three
months (6 to 20 weeks) postoperatively

Numerator

The average change (preoperative to three months post-operative) in leg
pain for all patients in the denominator

Required Exclusions

The following exclusions must be applied to the eligible population:
• Patient had any additional spine procedures performed on the same date
as the lumbar discectomy laminotomy

Measure Scoring

Number

Interpretation of Score

Higher score indicates better quality

Measure Type

Outcome
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Measure Logic / Flow Chart

Was the patient born on
or prior to 01/01/1998?

2018 Spine Surgery:
Lumbar Discectomy/Laminotomy
Functional Status and Quality of Life
Outcome Measures

No

Yes
Did the patient undergo a lumbar discectomy laminotomy
procedure (Single Disc-Lami Value Set) for a diagnosis of
disc herniation (Disc Herniation Value Set) performed by
an eligible provider in an eligible specialty during the
measurement period (01/01/2016 through 12/31/2016)?

No

PATIENT NOT
INCLUDED IN
MEASURE

Yes
Did the patient have any
other spine procedures
performed on the same
date as the lumbar
discectomy/laminotomy?

Yes

No

PATIENT INCLUDED IN
ELIGIBLE POPULATION

Did patient have
pre-op ODI within
three months prior
to procedure?
Yes
Did patient have
three month postop ODI within 6 to
20 weeks post
procedure?
Yes
Patient included in
average change in
functional status
score at three
months measure.

No
No

PATIENT NOT
INCLUED IN
MEASURE
CALCULATION

No

Did patient have
pre-op VAS to
measure back pain
within three months
prior to procedure?

Did patient have
pre-op VAS to
measure leg pain
within three months
prior to procedure?

Yes

Yes

Did patient have
pre-op PROMIS-10
within three months
prior to procedure?
No
No

No

PATIENT NOT
INCLUED IN
MEASURE
CALCULATION

No
No

Yes

Did patient have
three month postop VAS to measure
back pain within 6 to
20 weeks post
procedure?

Did patient have
three month postop VAS to measure
leg pain within 6 to
20 weeks post
procedure?

Yes

Yes

Yes

Patient included in
average change in
back pain score at
three months
measure.

Patient included in
average change in
leg pain score at
three months
measure.

Patient included in
average change in
quality of life score
at three months
measure.

Did patient have
three month postop PROMIS-10
within 6 to 20 weeks
post procedure?
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Process and Timeline Overview
Process Step
Registration
Registration must be completed prior to data submission. Please refer to the
Clinic and Provider Registration Instructions guide available on the Resources
tab of the MNCM Data Portal as well as on MNCM.org for additional
information.
Pre-Submission Data Certification
See Section I for more information.
Data Collection and Submission
See Sections II and III for more information.
Data Validation
See Sections III-B and IV for more information.
Two-Week Medical Group Review Period of Preliminary Statewide Results
See Section IV for more information.
Final Data Results

Important Dates
November 2017 to
February 2018

Submit document by
April 16, 2018
MNCM Data Portal is
open for submission
April 16 to May 11,
2018
May-July 2018
July 2018
Fall 2018

Sharing Data Files and Protected Health Information (PHI) Securely:
It is important that data files and PHI are shared securely between organizations. Email is
not a secure mode of transmitting data.
• Do not send a data file or patient list that contains PHI to MNCM via email.
• Do not include any identifiable patient information in the body of an email message.
o Examples of PHI include (but are not limited to) the following: patient ID, patient
date of birth, patient name, patient address or zip code, insurance member ID, dates
of service.
Please contact support@mncm.org to determine a secure mode of transmission.
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Data Submission Resources
The Spine Surgery resources page contains useful documents and answers to Frequently Asked
Questions. To access the resources page:
1. Log in to the MNCM Data Portal.
2. Click on the Resources tab.
3. Select Cycle B – Spine Surgery from the drop down menu.
a. Download the following documents:
i. 2018 Spine Surgery: Lumbar Discectomy/Laminotomy Data Collection Guide
ii. 2018 Spine Surgery: Lumbar Discectomy/Laminotomy Pre-Submission Data
Certification Form
iii. 2018 Spine Surgery: Lumbar Discectomy/Laminotomy Data Collection
Spreadsheet Template
iv. Optional: 2018 Spine Surgery: Lumbar Discectomy/Laminotomy Data Collection
Form. This is a patient-level form that is most useful for medical groups and
clinics using paper records.
v. 2018 Spine Surgery: Lumbar Discectomy/Laminotomy Value Set Dictionary. This
workbook contains all Value Sets referenced in this guide.
For questions not answered by the information available on the Resources tab, contact MNCM at
support@mncm.org or 612-746-4522.
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Agreements & Pre-Submission Data Certification

Section I: Agreements and Pre-Submission Data Certification
Clinic and provider registration as well as the electronic signing of the Business Associate Agreement
(BAA), the Direct Data Submission (DDS) Terms and Conditions, and selection of a Data File Transfer
option must be completed prior to data submission.

A. Business Associate Agreement

A business associate is a person or entity that performs certain functions or activities that involve the
use or disclosure of PHI on behalf of, or provides services to, a covered entity. The HIPAA Privacy Rule
requires that a covered entity obtain satisfactory assurances from its business associate that the
business associate will appropriately safeguard the PHI it receives on behalf of the covered entity. Since
MNCM is performing services on behalf of medical groups submitting data that involve the use and
disclosure of PHI, it is necessary for covered entities submitting PHI to MNCM to sign a BAA.
To electronically sign the BAA:
1. Log in to the MNCM Data Portal.
2. Click on the Home tab.
3. Click on the BAA Agreement link under the Spine Surgery - Lumbar Discectomy/Laminotomy
measure heading.
4. Review the text, click the check box at the bottom of the Agreement and click OK.
a. Once electronically signed, the Agreement applies to all DDS measures and does not
need to be signed again unless provisions of the Agreement change.
b. Failure to electronically sign the Agreement will preclude the medical group from
submitting data.

B. Direct Data Submission Terms and Conditions

Please see Appendix A for detailed information about the DDS Terms and Conditions.
To confirm agreement with the DDS Terms and Conditions:
1. Log in to the MNCM Data Portal.
2. Click on the Home tab.
3. Click on the DDS Terms & Conditions link under the Spine Surgery - Lumbar
Discectomy/Laminotomy measure heading.
4. Review the text, click the check box at the bottom of the DDS Terms and Conditions and click
Select.
a. Failure to agree to the DDS Terms and Conditions will preclude the medical group from
submitting data for the measure.
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C. Data File Transfer Selection
Beginning in 2014, the Minnesota Department of Health (MDH) has requested the receipt of patient
level data. MDH has assured MNCM that medical groups are permitted to disclose this patient-level data
to MDH under applicable law (including Minnesota law and HIPAA), because it will be used by MDH only
for public health activities, health oversight activities, or other activities required or authorized by state
or federal law. A list of the data elements to be shared with MDH for each measure is available in the
MNCM Data Portal under the Resources tab by selecting Minnesota Statewide Quality Reporting and
Measurement System from the drop-down menu.
MDH will use patient level data to:
•
•
•
•
•
•

Research and analyze health disparities
Design and evaluate public health interventions
Publicly report summary results
Research risk adjustment methodologies
Benchmark and evaluate Health Care Homes
Validate quality measure results

MDH will not use patient level data to pursue investigatory or regulatory activities.
Medical groups must indicate on the MNCM Data Portal whether they choose to allow MNCM to share
patient-level data with MDH.
1. Log in to the MNCM Data Portal.
2. Click on Data Files Transfer on the Home tab in the MNCM Data Portal under the Spine Surgery
- Lumbar Discectomy/Laminotomy section.
3. Choose one of the two data sharing options:
YES – My organization agrees to have MNCM share our patient-level data with MDH for
specified measures.
NO – My organization does not agree to have MNCM share our patient-level data with MDH.
3. Click Save.
If a selection error is made, please contact MNCM at support@mncm.org to request a selection change.
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D. Pre-Submission Data Certification
To aid medical groups in the identification of the correct eligible patient population, MNCM will review
each medical group’s source code and/or methodology for producing the eligible population. Medical
groups document the methodology and source code on a template provided by MNCM and upload the
template to the MNCM Data Portal for review. This standard template is provided to ensure that all
medical groups are using the same required set of criteria to identify the eligible population. MNCM
recommends that medical groups complete this review process prior to using the source code and/or
methodology to identify the eligible population and collect data.
This review process is intended to identify potential issues prior to data submission, thus avoiding
rework for medical groups; however, the responsibility to submit an accurate eligible population rests
with the medical group.
To download and complete the template and submit it for certification:
1. Login to the MNCM Data Portal.
2. Under the Resources tab, select Cycle B – Spine Surgery from the drop-down menu.
3. Download the Spine Surgery: Lumbar Discectomy/Laminotomy Pre-Submission Data
Certification Form.
4. Complete and save the form.
5. Login to the MNCM Data Portal and from the Home page click on Denominator Certification
under the Spine Surgery - Lumbar Discectomy/Laminotomy header. Follow the instructions to
upload the saved form to the MNCM Data Portal.
MNCM will review the information and will either (1) contact the medical group if more clarification is
needed or (2) certify the methodology. An automatic e-mail will notify the medical group when the
method is certified.
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Section II: Data Collection
A. Eligible Population Identification

After Pre-submission Data Certification is complete, medical groups may query their systems to identify
the eligible population. MNCM recommends saving all original queries, spreadsheets and other
documentation of the process used to identify the eligible population for potential review. This
information may be requested during validation.

Preparing the eligible population list:
1. Query the system to generate a list according to the eligible population as described in the
measure specifications.
2. Remove patients from the list who meet any of the criteria described in the required exclusions
section of the measure specifications.
3. De-duplicate the list; one record per procedure.
4. Review the number of patients in the population and consider whether the number is accurate.
If not, correct the methodology and/or query.

Total Population

This measure requires total population data submission. The submission of all patients meeting
eligibility criteria is required regardless of the assessment tool completion status. Sampling is not
allowed.

Patient Attribution
The patient is attributed to the surgeon who performs the procedure. The patient is also attributed to
the clinic site where their preoperative visit with the surgeon occurred.
If a surgeon has left the medical group, the patient must remain in the data file if they meet eligibility
criteria.

Helpline: 612-746-4522 | E-mail: support@mncm.org | MNCM Data Portal: https://data.mncm.org/login
© MN Community Measurement, 2017. All rights reserved.
4

2018 Spine Surgery:
Lumbar Discectomy/Laminotomy
Data Collection
B. Data Collection

After the eligible population is identified, data will need to be collected for the elements listed in the
Data Elements and Field Specifications table.
Data collection occurs after:
1. The medical group’s billing and medical record updates are complete for the measurement
period;
2. The patient identification methodology is certified by MNCM; and
3. The total eligible population list is prepared.
The medical record is considered the true source of information. Administrative claims data or
documentation outside of the medical record may be useful in the identification of patient
characteristics and/or data collection of specific data elements. However, upon audit, submitted data
elements will be verified against the medical record regardless of the use of other information in the
preparation of the data file for submission.

Data Collection: Using Multiple Data Abstractors

For medical groups that must collect data via manual chart abstraction, MNCM recommends that one
data abstractor is used, when possible. If more than one abstractor is needed, maximize inter-rater
reliability (IRR) by training all abstractors about the definitions of each data element and about the
location of clinical information in the patient record.
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Data Elements and Field Specifications

Use this section to build your data file for submission. The specifications contain detailed information regarding each column in the submission
file, including column order, definitions, examples, and appropriate formatting.
Summary of Changes

Change of Tobacco Status (Column V) to optional field.

Column

Field Name

Notes

Excel Format

Example

A

Clinic ID

Enter the MNCM Clinic ID of the clinic to which the patient is attributed based
on the attribution methodology detailed in Section II.
MNCM assigns clinic IDs at the time of registration. Clinic IDs are listed in the
MNCM Data Portal on the Clinics tab. Do NOT use the medical group ID.
A blank field will create an ERROR upon submission.
Quality Check: Verify that the ID in each cell matches the clinic ID in the MNCM
Data Portal.

Text

905

B

Patient ID

Enter a unique patient ID to identify each patient.
The patient’s medical record number may be used.
Medical groups or clinics that choose not to use the medical record number
should:

Text

56609

NOT use the patient’s Social Security Number
Maintain a crosswalk between the patient ID and the medical record
number or patient name and Date of Birth (DOB)
Medical groups or clinics that do not have an EHR should also maintain a
crosswalk between patient ID and patient name and DOB as a tool to locate
records during audit.
A blank field will create an ERROR upon submission.
•
•

Quality Check: Verify that patient’s procedure was not duplicated. However, if a
duplicate is found, make sure that the patient has undergone multiple separate
lumbar discectomy/laminotomy procedures during the measurement period.
Helpline: 612-746-4522 | E-mail: support@mncm.org | MNCM Data Portal: https://data.mncm.org/login
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Column

Field Name

Notes

Excel Format

Example

C

Patient Date of
Birth

Enter the patient’s date of birth. Patient must be 18 years or older as of January
1 of the measurement period.

Date
(mm/dd/yyyy)

10/30/1985

•

The date of birth range for this age group is on or before 01/01/1998.

A blank field or a value outside of the allowable range will create an ERROR upon
submission.
Quality Check: Verify that each date of birth is within the accepted range
D

Patient Gender

Enter the patient’s gender:
Female = F
Male = M
Unknown = U
Unknown should be utilized for transgender or androgynous patients or in
situations when the patient’s gender is not available in the record.
A blank field will create an ERROR upon submission.
Quality Check: Verify that each cell has an accepted code.

Text

F

E

Patient Zip
Code

Enter the patient’s five-digit zip code of primary residence at the most recent
encounter on or prior to 05/20/2017.
If extraction results in a nine-digit zip code, all nine-digits may be submitted. The
MNCM Data Portal will only store the first five digits.
A blank field will create an ERROR upon submission.
Quality Check: Verify the zip code is five digits and that each cell has data.

Text

55111

F

Race/Ethnicity1

Number

1

G

Race/Ethnicity2

H

Race/Ethnicity3

I

Race/Ethnicity4

Please refer to a separate document entitled REL Data Elements, Field
Specifications & Codes for Column F-N field definitions and specifications. This
document can be found in the MNCM Data Portal under the Resources tab in the
Race/Ethnicity/Language Data (REL) section, or on MNCM.org under Submitting
Data > Training and Guidance > Data Collection Guides.

J

Race/Ethnicity5
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Column

Field Name

K

Country of
Origin Code

L

Country of
Origin Other

M

Primary
Language Code

Notes
For more information about collecting this data from patients, refer to the
Handbook on the Collection of Race Ethnicity and Language Data available on
MNCM.org under Submitting Data > Training & Guidance > Data Collection
Guides.

Quality Checks: Verify that each cell has an accepted code. Blank fields (if data is
not available) are acceptable

Excel Format

Example

Number

2

Text

Country A

Number

1

Text

Language B

N

Primary
Language Other

O

Surgeon NPI
Number

Enter the ten-digit NPI number of the surgeon who performed the lumbar
discectomy/laminotomy procedure.
A blank field will create an ERROR upon submission.
Quality Check: Verify that each cell has data.

Text

1997993992

P

Provider
Specialty Code

Enter the specialty code of the surgeon performing the procedure:
22 = Orthopedic Medicine/Surgery
18 = Neurosurgery
A blank field will create an ERROR upon submission.
Quality check: Verify that each cell has an accepted code.

Number

22

Q

Insurance
Coverage Code
Insurance
Coverage Other
Description

Please refer to a separate document entitled Insurance Coverage Data Elements,
Field Specifications & Codes for these field specifications. This document can be
found via the link above, in the MNCM Data Portal under the Resources tab in
the Insurance Coverage Field Specs & Codes for DDS section, or on MNCM.org
under Submitting Data > Training and Guidance > Data Collection Guides.

Number

1

Text

WORKERS
COMPENSATION
ONLY

R
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2018 Spine Surgery: Lumbar Discectomy/Laminotomy
Data Collection
Column
S

Field Name
Insurance Plan
Member ID

Notes
• Enter codes corresponding to the patient’s most recent insurance on or
prior to 05/20/2017.

Excel Format
Text

Example
FBZXV1234

Quality Check: Verify that each cell has an accepted code and that all 99 codes
have a name entered in Column R. Verify that Social Security Numbers are NOT
submitted.
T

Height Inches

Enter the patient’s height in inches. Submit the value as recorded in the patient
record, including decimal points if applicable. Height must be collected
(measured) in a clinical setting and not a patient reported value.
Leave BLANK if height is not documented in the medical record.
Quality Check: If data is entered, verify that the value is reasonable for a
patient’s height measured in inches.

Number

62.5

U

Weight Pounds

Enter the patient’s preoperative weight in pounds. Submit the value as recorded
in the patient record, including decimal points if applicable. Use the most recent
weight within six months prior to the procedure. Weight must be collected
(measured) in a clinical setting and not a patient reported value.

Number

130

Leave BLANK if weight within six months prior to the procedure is not
documented in the medical record.
Quality Check: If data is entered, verify that the value is reasonable for a
patient’s weight measured in pounds.
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2018 Spine Surgery: Lumbar Discectomy/Laminotomy
Data Collection
Column

Field Name

Notes

Excel Format

V

Tobacco Status
CHANGE for
2018

Enter the code that corresponds to the patient’s preoperative tobacco status.
Number
1 = Tobacco free (patient does not use tobacco; patient was a former user and
is not a current user)
2 = No documentation
3 = Current tobacco user (tobacco includes any amount of cigarettes, cigars,
pipes or smokeless tobacco; E-cigarettes are not considered tobacco
products)

Example
1

Quality Check: Verify that each cell has an accepted code.
W

Prior Back
Surgery

History of prior lumbar back surgery. Time frame of prior lumbar surgery is
unlimited; the intent is to capture any history of prior back surgery performed
either by the current medical group or another practice. Enter the appropriate
code to indicate if the patient had prior lumbar surgery:

Number

1

Date
(mm/dd/yyyy)

11/10/2016

1 = No prior back surgery in the lumbar region
2 = Prior back surgery in the lumbar region with fusion (with or without
instrumentation)
3 = Prior back surgery in the lumbar region without fusion (no instrumentation
or bone graft that fuses vertebrae)
If the patient has a history of procedures including both fusion and without
fusion, enter 2 as fusion reflects a procedure of higher complexity.
A blank field will create an ERROR upon submission.
Quality Check: Verify that each cell has an accepted code.
X

Date of
Procedure

Enter the date of the lumbar discectomy/laminotomy procedure.
A blank field or value outside of the measurement period will create an ERROR
upon submission.
Quality Check: Verify that each date is within the accepted range.
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2018 Spine Surgery: Lumbar Discectomy/Laminotomy
Data Collection
Column

Field Name

Notes

Excel Format

Example

Y

Facility ID

Enter the code for the facility where the lumbar discectomy/laminotomy
procedure was performed. Please see Appendix C for codes.

Text

41

A blank field will create an ERROR upon submission.
Quality Check: Verify that each cell has an accepted code. If 999 is entered,
verify that text is entered in Column Z for this row.
Z

Facility Other
Description

If the Facility ID (column Y) = 999 Other, enter the description of the location
where the lumbar discectomy/laminotomy was performed.
Quality Check: For all fields with text, verify that code 999 is entered in the
Facility ID field (column Y).

Text

Elk Ridge
Surgery
Center

AA

Facility Type

Enter the type of facility in which the lumbar discectomy/laminotomy procedure
was performed:
1 = Hospital
2 = Free Standing Outpatient Ambulatory Surgery Center
A blank field will create an ERROR upon submission.
Quality check: Verify that each cell has an accepted code.

Number

1

Please see Appendix D for more information about the scoring of and the data submission options for the Oswestry Disability Index (ODI)
tool.
AB

Preop ODI Date

Enter the date on which the preoperative Oswestry Disability Index (ODI) was
completed by the patient. If more than one preoperative ODI was obtained, use
the ODI that is the most recent and prior to the procedure.

Date
(mm/dd/yyyy)

Leave BLANK if a preoperative ODI was not obtained.
Quality Checks: If a date is entered, verify that the date is valid.
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2018 Spine Surgery: Lumbar Discectomy/Laminotomy
Data Collection
Column

Field Name

Notes

Excel Format

Example

AC

Preop ODI
Summary Score

Enter the value of the patient’s preoperative summary ODI score.
Leave BLANK if a preoperative ODI was not obtained, the patient answered
seven or fewer questions, OR if submitting individual values and not the
summary score.

Number;
whole
numbers only

67

Number;
Whole
numbers only

2

Quality Check: If data is entered, verify that each cell has a value between zero
and 100.
AD

Preop ODI Pain

Enter the value that corresponds with the patient’s preoperative selection for
ODI Section 1- Pain intensity.
0 = I have no pain at the moment.
1 = The pain is very mild at the moment.
2 = The pain is moderate at the moment.
3 = The pain is fairly severe at the moment.
4 = The pain is very severe at the moment.
5 = The pain is the worst imaginable at the moment.
If patient selects more than one response to a question, submit the worst
(higher numeric value) response.
Leave BLANK if the patient did not answer the question or if a preoperative ODI
was not obtained.
Quality Check: If data is entered, verify that each cell has a value between zero
and five.
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2018 Spine Surgery: Lumbar Discectomy/Laminotomy
Data Collection
Column

Field Name

Notes

Excel Format

Example

AE

Preop ODI Care

Enter the value that corresponds with the patient’s preoperative selection for
ODI Section 2- Personal Care (washing, dressing, etc.).
0 = I can look after myself normally without causing additional pain.
1 = I can look after myself normally but it is very painful.
2 = It is painful to look after myself and I am slow and careful.
3 = I need some help but manage most of my personal care.
4 = I need help every day in most aspects of my personal care.
5 = I do not get dressed, I wash with difficulty and stay in bed.
If patient selects more than one response to a question, submit the worst
(higher numeric value) response.
Leave BLANK if the patient did not answer the question or if a preoperative ODI
was not obtained.
Quality Check: If data is entered, verify that each cell has a value between zero
and five.

Number;
Whole
numbers only

1

AF

Preop ODI
Lifting

Enter the value that corresponds with the patient’s preoperative selection for
ODI Section 3- Lifting.
0 = I can lift heavy weights without additional pain.
1 = I can lift heavy weights but it give me additional pain.
2 = Pain prevents me from lifting heavy weights off the floor but I can
manage if they are conveniently positioned, e.g. on a table.
3 = Pain prevents me from lifting heavy weights, but I can manage light to
medium weights if off they are conveniently positioned.
4 = I can lift only very light weights.
5 = I cannot lift ot carry anything at all.
If patient selects more than one response to a question, submit the worst
(higher numeric value) response. Leave BLANK if the patient did not answer the
question or if a preoperative ODI was not obtained.
Quality Check: If data is entered, verify that each cell has a value between zero
and five.

Number;
Whole
numbers only

4
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2018 Spine Surgery: Lumbar Discectomy/Laminotomy
Data Collection
Column

Field Name

Notes

Excel Format

Example

AG

Preop ODI
Walking

Enter the value that corresponds with the patient’s preoperative selection for
ODI Section 4- Walking.
0 = Pain does not prevent me from walking any distance.
1 = Pain prevents me from walking more than one mile.
2 = Pain prevents me from walking more than a quarter of a mile.
3 = Pain prevents me from walking more than 100 yards.
4 = I can only walk using a cane or crutches.
5 = I am in bed most of the time and have to crawl to the toilet.
If patient selects more than one response to a question, submit the worst
(higher numeric value) response.
Leave BLANK if the patient did not answer the question or if a preoperative ODI
was not obtained.
Quality Check: If data is entered, verify that each cell has a value between zero
and five.

Number;
Whole
numbers only

2

AH

Preop ODI
Sitting

Enter the value that corresponds with the patient’s preoperative selection for
ODI Section 5- Sitting.
0 = I can sit in any chair as long as I like.
1 = I can sit in my favorite chair as long as I like.
2 = Pain prevents me from sitting more than one hour.
3 = Pain prevents me from sitting more than half an hour.
4 = Pain prevents me from sitting more than 10 minutes.
5 = Pain prevents me from sitting at all.
If patient selects more than one response to a question, submit the worst
(higher numeric value) response.
Leave BLANK if the patient did not answer the question or if a preoperative ODI
was not obtained.
Quality Check: If data is entered, verify that each cell has a value between zero
and five.

Number;
Whole
numbers only

1
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2018 Spine Surgery: Lumbar Discectomy/Laminotomy
Data Collection
Column

Field Name

Notes

Excel Format

Example

AI

Preop ODI
Standing

Enter the value that corresponds with the patient’s preoperative selection for
ODI Section 6- Standing.
0 = I can stand as long as I want without additional pain.
1 = I can stand as long as I want but it gives me additional pain.
2 = Pain prevents me from standing more than one hour.
3 = Pain prevents me from standing more than half an hour.
4 = Pain prevents me from standing more than 10 minutes.
5 = Pain prevents me from standing at all.
If patient selects more than one response to a question, submit the worst
(higher numeric value) response.
Leave BLANK if the patient did not answer the question or if a preoperative ODI
was not obtained.
Quality Check: If data is entered, verify that each cell has a value between zero
and five.

Number;
Whole
numbers only

3

AJ

Preop ODI
Sleeping

Enter the value that corresponds with the patient’s preoperative selection for
ODI Section 7- Sleeping.
0 = My sleep is never interrupted by pain.
1 = My sleep is occassionally interrupted by pain.
2 = Because of pain I have less than 6 hours of sleep.
3 = Because of pain I have less than 4 hours of sleep.
4 = Because of pain I have less than 2 hours of sleep.
5 = Pain prevents me from sleeping at all.
If patient selects more than one response to a question, submit the worst
(higher numeric value) response.
Leave BLANK if the patient did not answer the question or if a preoperative ODI
was not obtained.
Quality Check: If data is entered, verify that each cell has a value between zero
and five.

Number;
Whole
numbers only

1
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2018 Spine Surgery: Lumbar Discectomy/Laminotomy
Data Collection
Column

Field Name

Notes

Excel Format

Example

AK

Preop ODI Sex

Enter the value that corresponds with the patient’s preoperative selection for
ODI Section 8- Sex life.
0 = My sex life is normal and causes no additional pain.
1 = My sex life is normal but causes some additional pain.
2 = My sex life is nearly normal but is very painful.
3 = My sex life is severly restricted by pain.
4 = My sex life is nearly nonexistant because of pain.
5 = Pain prevents me from having any sex life at all.
If patient selects more than one response to a question, submit the worst
(higher numeric value) response.
Leave BLANK if the patient did not answer the question or if a preoperative ODI
was not obtained.
Quality Check: If data is entered, verify that each cell has a value between zero
and five.

Number;
Whole
numbers only

2

AL

Preop ODI
Social

Enter the value that corresponds with the patient’s preoperative selection for
ODI Section 9- Social Life.
0 = My social life is normal and causes no additional pain.
1 = My social life is normal but increases the degree of pain.
2 = Pain has no significant effect on my social life apart from limiting my more
energetic interests.
3 = Pain has restricted my social life and I do not go out as often.
4 = Pain has restricted my social life to home.
5 = I have no social life becasue of pain.
If patient selects more than one response to a question, submit the worst
(higher numeric value) response.
Leave BLANK if the patient did not answer the question or if a preoperative ODI
was not obtained.
Quality Check: If data is entered, verify that each cell has a value between zero
and five.

Number;
Whole
numbers only

0
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2018 Spine Surgery: Lumbar Discectomy/Laminotomy
Data Collection
Column

Field Name

Notes

Excel Format

Example

AM

Preop ODI
Travelling

Enter the value that corresponds with the patient’s preoperative selection for
ODI Section 10- Travelling.
0 = I can travel anywhere without pain.
1 = I can travel anywhere but it gives me additional pain.
2 = Pain is bad but I’m able to manage trips over two hours.
3 = Pain restricts me to trips on less than one hour.
4 = Pain restricts me to short necessary trips of under 30 minutes.
5 = Pain prevents me from travelling except to receive treatment.
If patient selects more than one response to a question, submit the worst
(higher numeric value) response.
Leave BLANK if the patient did not answer the question or if a preoperative ODI
was not obtained.
Quality Check: If data is entered, verify that each cell has a value between zero
and five.

Number;
Whole
numbers only

0

Please see Appendix D for more information about the Visual Analog Scale (VAS) for Pain tool.
AN

Preop VAS Pain
Date

Enter the date when the preoperative VAS Pain score was completed by the
Date
patient. If more than one preoperative VAS Pain score was obtained, use the VAS (mm/dd/yyyy)
Pain score that is the most recent and prior to the procedure.
Leave BLANK if a preoperative VAS Pain score was not obtained.
Quality Check: If a date is entered, verify dates are valid.
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2018 Spine Surgery: Lumbar Discectomy/Laminotomy
Data Collection
Column

Field Name

Notes

Excel Format

Example

AO

Preop VAS Pain
Value- Back

Enter the value that corresponds with the patient’s preoperative selection on
the VAS Pain scale for back pain. The VAS Pain scale is a continuous line under
which a patient places an “X” to indicate their level of pain on the continuum.
Valid values range from 0 (No Pain) to 10 (Intolerable) in 0.5 increments (e.g., 0,
0.5, 1.0, 1.5, 2.0, etc.
If a patient selects more than one response or selects a line between boxes,
submit the worst (higher numeric value) response.

Number;
One decimal
point

7.5

Number;
One decimal
point

7.5

Leave BLANK if the patient did not answer the question or if a preoperative VAS
score was not obtained.
Quality Check: If data is entered, verify that each cell has a value between zero
and ten.
AP

Preop VAS Pain
Value- Leg

Enter the value that corresponds with the patient’s preoperative selection on
the VAS Pain scale for leg pain. The VAS Pain scale is a continuous line under
which a patient places an “X” to indicate their level of pain on the continuum.
Valid values range from 0 (No Pain) to 10 (Intolerable) in 0.5 increments (e.g., 0,
0.5, 1.0, 1.5, 2.0, etc.
If a patient selects more than one response or selects a line between boxes,
submit the worst (higher numeric value) response.
Leave BLANK if the patient did not answer the question or if a preoperative VAS
score wase not obtained.
Quality Check: If data is entered, verify that each cell has a value between zero
and ten.
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2018 Spine Surgery: Lumbar Discectomy/Laminotomy
Data Collection
Column

Field Name

Notes

Excel Format

Example

Please see Appendix D for more information about the PROMIS Global Health 10 (PROMIS-10).
AQ

Preop PGH Date

Enter the date on which the preoperative PROMIS-10 was completed by the
patient. If more than one preoperative PROMIS-10 was obtained, use the most
recent and prior to the procedure.
Leave BLANK if a preoperative PROMIS-10 was not obtained preoperative.
Quality Check: If a date is entered, verify dates are valid.

Date
(mm/dd/yyyy)

05/28/2016

AR

Preop PGH 1
Health

Enter the value that corresponds with the patient’s preoperative response to the
PROMIS-10 question regarding general health rating.
1 = Poor
2 = Fair
3 = Good
4 = Very Good
5 = Excellent
Leave BLANK if the patient did not answer the question, if the patient selected
more than one response or if a preoperative PROMIS-10 was not obtained.
Quality Check: If data is entered, verify that each cell has a value between one
and five.

Number,
Whole
numbers only

3

AS

Preop PGH 2
Quality

Enter the value that corresponds with the patient’s preoperative response to the
PROMIS-10 question regarding general quality of life.
1 = Poor
2 = Fair
3 = Good
4 = Very Good
5 = Excellent
Leave BLANK if the patient did not answer the question, if the patient selected
more than one response or if a preoperative PROMIS-10 was not obtained.
Quality Check: If data is entered, verify that each cell has a value between one
and five.

Number,
Whole
numbers only

3
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2018 Spine Surgery: Lumbar Discectomy/Laminotomy
Data Collection
Column

Field Name

Notes

Excel Format

Example

AT

Preop PGH 3
Physical

Enter the value that corresponds with the patient’s preoperative response to the
PROMIS-10 question regarding general physical health.
1 = Poor
2 = Fair
3 = Good
4 = Very Good
5 = Excellent
Leave BLANK if the patient did not answer the question, if the patient selected
more than one response or if a preoperative PROMIS-10 was not obtained.
Quality Check: If data is entered, verify that each cell has a value between one
and five.

Number,
Whole
numbers only

3

AU

Preop PGH 4
Mental

Enter the value that corresponds with the patient’s preoperative response to the
PROMIS-10 question regarding general mental health.
1 = Poor
2 = Fair
3 = Good
4 = Very Good
5 = Excellent
Leave BLANK if the patient did not answer the question, if the patient selected
more than one response or if a preoperative PROMIS-10 was not obtained.
Quality Check: If data is entered, verify that each cell has a value between one
and five.

Number,
Whole
numbers only

3
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2018 Spine Surgery: Lumbar Discectomy/Laminotomy
Data Collection
Column

Field Name

Notes

Excel Format

Example

AV

Preop PGH 5
Satis Social

Enter the value that corresponds with the patient’s preoperative response to the
PROMIS-10 question regarding general satisfaction with social activities and
relationships.
1 = Poor
2 = Fair
3 = Good
4 = Very Good
5 = Excellent
Leave BLANK if the patient did not answer the question, if the patient selected
more than one response or if a preoperative PROMIS-10 was not obtained.
Quality Check: If data is entered, verify that each cell has a value between one
and five.

Number,
Whole
numbers only

3

AW

Preop PGH 9
Soc Activities

Enter the value that corresponds with the patient’s preoperative response to the
PROMIS-10 question regarding ability to carry out social activities and roles.
1 = Poor
2 = Fair
3 = Good
4 = Very Good
5 = Excellent
Leave BLANK if the patient did not answer the question, if the patient selected
more than one response or if a preoperative PROMIS-10 was not obtained.
Quality Check: If data is entered, verify that each cell has a value between one
and five.

Number,
Whole
numbers only

3
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2018 Spine Surgery: Lumbar Discectomy/Laminotomy
Data Collection
Column

Field Name

Notes

Excel Format

Example

AX

Preop PGH 6
Phys Activities

Enter the value that corresponds with the patient’s preoperative response to the
PROMIS-10 question regarding ability to carry out physical activities.
1 = Not at all
2 = A little
3 = Moderately
4 = Mostly
5 = Completely
Leave BLANK if the patient did not answer the question, if the patient selected
more than one response or if a preoperative PROMIS-10 was not obtained.
Quality Check: If data is entered, verify that each cell has a value between one
and five.

Number,
Whole
numbers only

3

AY

Preop PGH 10
Emotional

Enter the value that corresponds with the patient’s preoperative response to the
PROMIS-10 question regarding emotional problems in the past seven days.
1 = Never
2 = Rarely
3 = Sometimes
4 = Often
5 = Always
Leave BLANK if the patient did not answer the question, if the patient selected
more than one response or if a preoperative PROMIS-10 was not obtained.
Quality Check: If data is entered, verify that each cell has a value between one
and five.

Number,
Whole
numbers only

3
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2018 Spine Surgery: Lumbar Discectomy/Laminotomy
Data Collection
Column

Field Name

Notes

Excel Format

Example

AZ

Preop PGH 8
Fatigue

Enter the value that corresponds with the patient’s preoperative response to the
PROMIS-10 question regarding fatigue on average in the past seven days.
1 = None
2 = Mild
3 = Moderate
4 = Severe
5 = Very Severe
Leave BLANK if the patient did not answer the question, if the patient selected
more than one response or if a preoperative PROMIS-10 was not obtained.
Quality Check: If data is entered, verify that each cell has a value between one
and five.

Number,
Whole
numbers only

3

BA

Preop PGH 7
Pain

Enter the value that corresponds with the patient’s preoperative response to
the PROMIS-10 question regarding pain rating in the past seven days using a
scale of zero (No Pain) to ten (Worst imaginable pain).

Number,
Whole
numbers only

3

Date
(mm/dd/yyyy)

2/9/2016

Leave BLANK if the patient did not answer the question, if the patient selected
more than one response or if a preoperative PROMIS-10 was not obtained.
Quality Check: If data is entered, verify that each cell has a value between zero
and ten.
BB

3 Mon Postop
ODI Date

Enter the date on which the three month postoperative ODI was completed by
the patient. The allowable date range for the three month assessment is six to
20 weeks after the procedure date. ODI’s obtained outside of the allowable
timeframe will not be included in measure calculation.
If more than one postoperative ODI was obtained during the six to 20 weeks
following the procedure, use the most recent score obtained during the
allowable timeframe.
Leave BLANK if a postoperative ODI was not obtained.
Quality Check: If a date is entered, verify dates are valid.
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2018 Spine Surgery: Lumbar Discectomy/Laminotomy
Data Collection
Column

Field Name

Notes

Excel Format

Example

BC

3 Mon Postop
ODI Summary
Score

Enter the value of the patient’s three month postoperative summary ODI score.

Number;
whole
numbers only

67

Number;
Whole
numbers only

2

Leave BLANK if a three month postoperative ODI was not obtained, the patient
answered seven or fewer questions, OR if submitting individual values and not
the summary score.
Quality Check: If data is entered, verify that each cell has a value between zero
and 100.

BD

3 Mon Postop
ODI Pain

Enter the value of the patient’s postoperative selection for ODI Section 1- Pain
intensity.
0 = I have no pain at the moment.
1 = The pain is very mild at the moment.
2 = The pain is moderate at the moment.
3 = The pain is fairly severe at the moment.
4 = The pain is very severe at the moment.
5 = The pain is the worst imaginable at the moment.
If patient selects more than one response to a question, submit the worst
(higher numeric value) response.
Leave BLANK if the patient did not answer the question or if a postoperative ODI
was not obtained.
Quality Check: If data is entered, verify that each cell has a value between zero
and five.
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2018 Spine Surgery: Lumbar Discectomy/Laminotomy
Data Collection
Column

Field Name

Notes

Excel Format

Example

BE

3 Mon Postop
ODI Care

Enter the value of the patient’s postoperative selection for ODI Section 2Personal Care (washing, dressing, etc.).
0 = I can look after myself normally without causing additional pain.
1 = I can look after myself normally but it is very painful.
2 = It is painful to look after myself and I am slow and careful.
3 = I need some help but manage most of my personal care.
4 = I need help every day in most aspects of my personal care.
5 = I do not get dressed, I wash with difficulty and stay in bed.
If patient selects more than one response to a question, submit the worst
(higher numeric value) response.
Leave BLANK if the patient did not answer the question or if a postoperative ODI
was not obtained.
Quality Check: If data is entered, verify that each cell has a value between zero
and five.

Number;
Whole
numbers only

1
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2018 Spine Surgery: Lumbar Discectomy/Laminotomy
Data Collection
Column

Field Name

Notes

Excel Format

Example

BF

3 Mon Postop
ODI Lifting

Enter the value that corresponds with the patient’s postoperative selection for
ODI Section 3- Lifting.
0 = I can lift heavy weights without additional pain.
1 = I can lift heavy weights but it give me additional pain.
2 = Pain prevents me from lifting heavy weights off the floor but I can
manage if they are conveniently positioned, e.g. on a table.
3 = Pain prevents me from lifting heavy weights, but I can manage light to
medium weights if off they are conveniently positioned.
4 = I can lift only very light weights.
5 = I cannot lift ot carry anything at all.
If patient selects more than one response to a question, submit the worst
(higher numeric value) response.
Leave BLANK if the patient did not answer the question or if a postoperative ODI
was not obtained.

Number;
Whole
numbers only

4

Quality Check: If data is entered, verify that each cell has a value between zero
and five.
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Field Name

Notes

Excel Format

Example

BG

3 Mon Postop
ODI Walking

Enter the value that corresponds with the patient’s postoperative selection for
ODI Section 4- Walking.
0 = Pain does not prevent me from walking any distance.
1 = Pain prevents me from walking more than one mile.
2 = Pain prevents me from walking more than a quarter of a mile.
3 = Pain prevents me from walking more than 100 yards.
4 = I can only walk using a cane or crutches.
5 = I am in bed most of the time and have to crawl to the toilet.
If patient selects more than one response to a question, submit the worst
(higher numeric value) response.
Leave BLANK if the patient did not answer the question or if a postoperative ODI
was not obtained.
Quality Check: If data is entered, verify that each cell has a value between zero
and five.

Number;
Whole
numbers only

2

BH

3 Mon Postop
ODI Sitting

Enter the value that corresponds with the patient’s postoperative selection for
ODI Section 5- Sitting.
0 = I can sit in any chair as long as I like.
1 = I can sit in my favorite chair as long as I like.
2 = Pain prevents me from sitting more than one hour.
3 = Pain prevents me from sitting more than half an hour.
4 = Pain prevents me from sitting more than 10 minutes.
5 = Pain prevents me from sitting at all.
If patient selects more than one response to a question, submit the worst
(higher numeric value) response.
Leave BLANK if the patient did not answer the question or if a postoperative ODI
was not obtained.

Number;
Whole
numbers only

1

Quality Check: If data is entered, verify that each cell has a value between zero
and five.
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BI

3 Mon Postop
ODI Standing

Enter the value that corresponds with the patient’s postoperative selection for
ODI Section 6- Standing.
0 = I can stand as long as I want without additional pain.
1 = I can stand as long as I want but it gives me additional pain.
2 = Pain prevents me from standing more than one hour.
3 = Pain prevents me from standing more than half an hour.
4 = Pain prevents me from standing more than 10 minutes.
5 = Pain prevents me from standing at all.
If patient selects more than one response to a question, submit the worst
(higher numeric value) response.
Leave BLANK if the patient did not answer the question or if a postoperative ODI
was not obtained.
Quality Check: If data is entered, verify that each cell has a value between zero
and five.

Number;
Whole
numbers only

3

BJ

3 Mon Postop
ODI Sleeping

Enter the value that corresponds with the patient’s postoperative selection for
ODI Section 7- Sleeping.
0 = My sleep is never interrupted by pain.
1 = My sleep is occassionally interrupted by pain.
2 = Because of pain I have less than 6 hours of sleep.
3 = Because of pain I have less than 4 hours of sleep.
4 = Because of pain I have less than 2 hours of sleep.
5 = Pain prevents me from sleeping at all.
If patient selects more than one response to a question, submit the worst
(higher numeric value) response.
Leave BLANK if the patient did not answer the question or if a postoperative ODI
was not obtained.

Number;
Whole
numbers only

1

Quality Check: If data is entered, verify that each cell has a value between zero
and five.
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Notes
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BK

3 Mon Postop
ODI Sex

Enter the value that corresponds with the patient’s postoperative selection for
ODI Section 8- Sex life.
0 = My sex life is normal and causes no additional pain.
1 = My sex life is normal but causes some additional pain.
2 = My sex life is nearly normal but is very painful.
3 = My sex life is severly restricted by pain.
4 = My sex life is nearly nonexistant because of pain.
5 = Pain prevents me from having any sex life at all.
If patient selects more than one response to a question, submit the worst
(higher numeric value) response.
Leave BLANK if the patient did not answer the question or if a postoperative ODI
was not obtained.
Quality Check: If data is entered, verify that each cell has a value between zero
and five.

Number;
Whole
numbers only

2

BL

3 Mon Postop
ODI Social

Enter the value that corresponds with the patient’s postoperative selection for
ODI Section 9- Social Life.
0 = My social life is normal and causes no additional pain.
1 = My social life is normal but increases the degree of pain.
2 = Pain has no significant effect on my social life apart from limiting my more
energetic interests.
3 = Pain has restricted my social life and I do not go out as often.
4 = Pain has restricted my social life to home.
5 = I have no social life becasue of pain.
If patient selects more than one response to a question, submit the worst
(higher numeric value) response.
Leave BLANK if the patient did not answer the question or if a postoperative ODI
was not obtained.
Quality Check: If data is entered, verify that each cell has a value between zero
and five.

Number;
Whole
numbers only

0
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Column

Field Name

BM

3 Mon Postop
ODI Travelling

BN

3 Mon Postop
VAS Pain Date

Notes
Enter the value that corresponds with the patient’s postoperative selection for
ODI Section 10- Travelling.
0 = I can travel anywhere without pain.
1 = I can travel anywhere but it gives me additional pain.
2 = Pain is bad but I’m able to manage trips over two hours.
3 = Pain restricts me to trips on less than one hour.
4 = Pain restricts me to short necessary trips of under 30 minutes.
5 = Pain prevents me from travelling except to receive treatment.
If patient selects more than one response to a question, submit the worst
(higher numeric value) response.
Leave BLANK if the patient did not answer the question or if a postoperative ODI
was not obtained.
Quality Check: If data is entered, verify that each cell has a value between zero
and five.

Excel Format

Example

Number;
Whole
numbers only

0

Enter the date on which the postoperative Visual Analog Scale (VAS) for Pain
score was completed by the patient. The allowable date range for the three
month assessment is six to 20 weeks after the procedure date. VAS Pain scores
obtained outside of the allowable timeframe will not be included in measure
calculation.
If more than one postoperative VAS Pain score was obtained during the six to 20
weeks following the procedure, use the most recent score obtained during the
allowable timeframe.
Leave BLANK if a postoperative VAS Pain score was not obtained.
Quality Check: If a date is entered, verify dates are valid.

Date
(mm/dd/yyyy)

10/27/2011
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Field Name

Notes

Excel Format

Example

BO

3 Mon Postop
VAS Pain ValueBack

Enter the value that corresponds with the patient’s postoperative selection on
the VAS Pain scale for back pain. The VAS Pain scale is a continuous line under
which a patient places an “X” to indicate their level of pain on the continuum.
Valid values range from 0 (No Pain) to 10 (Intolerable) in 0.5 increments (e.g., 0,
0.5, 1.0, 1.5, 2.0, etc.
If a patient selects more than one response or selects a line between boxes,
submit the worst (higher numeric value) response.
Leave BLANK if the patient did not answer the question or if a postoperative VAS
Pain score was not obtained.
Quality Check: If data is entered, verify that each cell has a value between zero
and ten.

Number;
One decimal
point

7.5

BP

3 Mon Postop
VAS Pain ValueLeg

Enter the value that corresponds with the patient’s postoperative selection on
the VAS Pain scale for leg pain. The VAS pain scale is a continuous line under
which a patient places an “X” to indicate their level of pain on the continuum.
Valid values range from 0 (No Pain) to 10 (Intolerable) in 0.5 increments (e.g., 0,
0.5, 1.0, 1.5, 2.0, etc.
If a patient selects more than one response or selects a line between boxes,
submit the worst (higher numeric value) response. Leave BLANK if the patient
did not answer the question or if a postoperative VAS Pain score was not
obtained.
Quality Check: If data is entered, verify that each cell has a value between zero
and ten.

Number;
One decimal
point

7.5
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BQ

BR

Field Name
3 Mon Postop
PGH Date

Notes
Enter the date on which the three month postoperative PROMIS-10 was
completed by the patient. The allowable date range for the three month
assessment is six to 20 weeks after the procedure date. PROMIS-10 results
obtained outside of the allowable timeframe will not be included in measure
calculation.
If more than one postoperative PROMIS-10 was obtained during the six to 20
weeks following the procedure, use the most recent result obtained during the
allowable timeframe.
Leave BLANK if a postoperative PROMIS-10 was not obtained.
Quality Check: If a date is entered, verify dates are valid.

3 Mon Postop
PGH 1 Health

Enter the value that corresponds with the patient’s postoperative response to
the PROMIS-10 question regarding general health rating.
1 = Poor
2 = Fair
3 = Good
4 = Very Good
5 = Excellent
Leave BLANK if the patient did not answer the question, if the patient selected
more than one response or if a postoperative PROMIS-10 was not obtained.
Quality Check: If data is entered, verify that each cell has a value between one
and five.

Excel Format

Example

Date
(mm/dd/yyyy)

05/28/2016

Number,
Whole
numbers only

3
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Field Name

Notes

Excel Format

Example

BS

3 Mon Postop
PGH 2 Quality

Enter the value that corresponds with the patient’s postoperative response to
the PROMIS-10 question regarding general quality of life.
1 = Poor
2 = Fair
3 = Good
4 = Very Good
5 = Excellent
Leave BLANK if the patient did not answer the question, if the patient selected
more than one response or if a postoperative PROMIS-10 was not obtained.
Quality Check: If data is entered, verify that each cell has a value between one
and five.

Number,
Whole
numbers only

3

BT

3 Mon Postop
PGH 3 Physical

Enter the value that corresponds with the patient’s postoperative response to
the PROMIS-10 question regarding general physical health.
1 = Poor
2 = Fair
3 = Good
4 = Very Good
5 = Excellent
Leave BLANK if the patient did not answer the question, if the patient selected
more than one response or if a postoperative PROMIS-10 was not obtained.
Quality Check: If data is entered, verify that each cell has a value between one
and five.

Number,
Whole
numbers only

3
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Field Name

Notes

Excel Format

Example

BU

3 Mon Postop
PGH 4 Mental

Enter the value that corresponds with the patient’s postoperative response to
the PROMIS-10 question regarding general mental health.
1 = Poor
2 = Fair
3 = Good
4 = Very Good
5 = Excellent
Leave BLANK if the patient did not answer the question, if the patient selected
more than one response or if a postoperative PROMIS-10 was not obtained.
Quality Check: If data is entered, verify that each cell has a value between one
and five.

Number,
Whole
numbers only

3

BV

3 Mon Postop
PGH 5 Satis
Social

Enter the value that corresponds with the patient’s postoperative response to
the PROMIS-10 question regarding general satisfaction with social activities and
relationships.
1 = Poor
2 = Fair
3 = Good
4 = Very Good
5 = Excellent
Leave BLANK if the patient did not answer the question, if the patient selected
more than one response or if a postoperative PROMIS-10 was not obtained.
Quality Check: If data is entered, verify that each cell has a value between one
and five.

Number,
Whole
numbers only

3
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Field Name

Notes

Excel Format

Example

BW

3 Mon Postop
PGH 9 Soc
Activities

Enter the value that corresponds with the patient’s postoperative response to
the PROMIS-10 question regarding ability to carry out social activities and roles.
1 = Poor
2 = Fair
3 = Good
4 = Very Good
5 = Excellent
Leave BLANK if the patient did not answer the question, if the patient selected
more than one response or if a postoperative PROMIS-10 was not obtained.
Quality Check: If data is entered, verify that each cell has a value between one
and five.

Number,
Whole
numbers only

3

BX

3 Mon Postop
PGH 6 Phys
Activities

Enter the value that corresponds with the patient’s postoperative response to
the PROMIS-10 question regarding ability to carry out physical activities.
1 = Not at all
2 = A little
3 = Moderately
4 = Mostly
5 = Completely
Leave BLANK if the patient did not answer the question, if the patient selected
more than one response or if a postoperative PROMIS-10 was not obtained.
Quality Check: If data is entered, verify that each cell has a value between one
and five.

Number,
Whole
numbers only

3
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Field Name

Notes

Excel Format

Example

BY

3 Mon Postop
PGH 10
Emotional

Enter the value that corresponds with the patient’s postoperative response to
the PROMIS-10 question regarding emotional problems in the past seven days.
1 = Never
2 = Rarely
3 = Sometimes
4 = Often
5 = Always
Leave BLANK if the patient did not answer the question, if the patient selected
more than one response or if a postoperative PROMIS-10 was not obtained.
Quality Check: If data is entered, verify that each cell has a value between one
and five.

Number,
Whole
numbers only

3

BZ

3 Mon Postop
PGH 8 Fatigue

Enter the value that corresponds with the patient’s postoperative response to
the PROMIS-10 question regarding fatigue on average in the past seven days.
1 = None
2 = Mild
3 = Moderate
4 = Severe
5 = Very Severe
Leave BLANK if the patient did not answer the question, if the patient selected
more than one response or if a postoperative PROMIS-10 was not obtained.
Quality Check: If data is entered, verify that each cell has a value between one
and five.

Number,
Whole
numbers only

3

CA

3 Mon Postop
PGH 7 Pain

Enter the value of the patient’s postoperative response to the PROMIS-10
question regarding pain rating in the last seven days using a scale of zero (No
Pain) to ten (Worst imaginable pain).
Leave BLANK if the patient did not answer the question, if the patient selected
more than one response or if a postoperative PROMIS-10 was not obtained.
Quality Check: If data is entered, verify that each cell has a value between zero
and ten.

Number,
Whole
numbers only

3
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C. Data Quality Checks

MNCM recommends that medical groups complete several quality checks of the data prior to file
upload. Quality checks improve data accuracy, reduce the likelihood of errors, and ensure that the data
can be successfully validated upon audit.
Quality Check 1: File Check
Use Excel’s AutoFilter feature to complete data quality checks of specific data elements in the Excel file.
To set the filter and review specific data elements:
1. Click inside any data cell and activate the AutoFilter by :
a. In Excel 2003, click the Data menu, point to Filter, and then click AutoFilter.
b. In Excel 2007, 2010, 2013 and 2016 click the Data tab and in the Sort & Filter area click
Filter.
2. Click on the drop-down boxes of any column and scan for key entry errors, “out-of-range” or
missing data and determine if the data needs to be corrected.
Quality Check 2: Verify Clinical Data
Verify the collected clinical data by reviewing a small sample of records (eight to 10) to compare with
the documentation within the patients’ medical records. If errors are identified, make the corrections in
the data file. Also consider whether the errors were isolated or indicative of a larger data collection
problem.
Quality Check 3: General
Complete the general quality checks outlined below:
1. Complete the quality checks listed in the Notes section of each data element in the Data
Elements and Field Specifications table.
2. Verify that excluded records were removed.
3. Verify that all fields intended to be left blank are indeed blank. Do NOT enter hyphens or zeroes.
4. Remove blank rows at the bottom of the Excel spreadsheet.
a. Press Ctrl/End to go to the bottom-most cell in the spreadsheet. If there are blank rows,
highlight them, right-click in the left margin, and select Delete.
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Section III: Data Submission
A. Data File Creation

Before proceeding with the file submission, be sure to:
• Complete all data collection and data entry.
• Complete data quality checks.
• Combine all clinic files onto one spreadsheet. All clinics in a medical group must be uploaded in
one, single file. The clinic identifier is the Clinic ID.
• Verify that each column is formatted according to measure specifications (TEXT, NUMBER, or
DATE formatting). Columns can be any width.
• Verify that all original columns remain in the spreadsheet even if there is no data in a column.
Do NOT delete any columns.
Once the above steps are completed:
1. Save the Excel template.
2. Save the file in CSV format.
a. The CSV file will be the data file uploaded to the MNCM Data Portal.
How to create a CSV file from an Excel file:

For Excel 2003 Users
For Excel 2007 Users
For Excel 2010, 2013 and 2016 Users
1. Open the original Excel file (.xls).
2. Activate the worksheet to be uploaded by clicking the worksheet tab.
3. Click File, Save As.
3. Click the Office Button
3. Click the File tab (upper left(upper left-hand corner
hand corner of screen); select
of screen); select Save
Save As.
As.
4. Navigate to the folder where the file will be saved.
5. Enter the file name.
6. At the bottom of the Save As dialog box, choose CSV (comma delimited) from the Save as type
drop-down.
7. Click Save. The following warning will appear: “…may contain features that are not compatible with
CSV. Do you want to keep the workbook in this format?” Click Yes.
8. Close the file. A message will appear: “Do you want to save this file...?” Click Yes or No.

NOTE: If corrections to the data are needed after the CSV file has been created; do NOT open the CSV
file in Excel to make these corrections. Doing so alters the data. To make changes, follow these steps:
1. Open the original Excel template.
2. Make changes in the Excel template.
3. Save the Excel template.
4. Save the file with the changes as a new CSV file.
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B. Data Submission
Click on Data Submission on the Home tab in the MNCM Data Portal under the Spine Surgery - Lumbar
Discectomy/Laminotomy section. Use the following steps to submit data to MNCM.
Step 1: Enter Denominator
Using the instructions below, manually enter denominator counts and information or complete and
upload a file with this information. Whether done manually or via a file upload, the information must be
completed for each clinic row. Once the information is populated, click on Save and Continue.
Manual Entry:
• Method Used for Data Collection: Select one of the methods from the drop-down box.
• REL Data Collection: Indicate if collection of race, Hispanic ethnicity, preferred language and
country of origin occurred using best practice methods. Best practice methods include:
o Race: Self-Report: Allowing patient to self-report their race and Hispanic ethnicity.
o Race: Reporting Multiple Races: NOT using a multi-racial category, allowing patients to
select more than one race AND using a system that allows the collection and reporting
of more than one race for each patient.
o Language: Self-Report: Allowing patient to self-report preferred language.
o Country: Self-Report: Allowing patient to self-report country of origin.
• Not Reporting: Check this box if a clinic is not reporting any data for this cycle of data collection.
o Provide a reason that the clinic is not reporting (e.g., no patients meet eligibility
criteria).
 Please be advised that MNCM’s policy requires ALL clinic sites within a medical
group to submit their data through the DDS process. Likewise, this is a condition
of participation in pay-for-performance programs.
File Upload:
1. Click on Download the Denominator Worksheet.
• Clinic names will display in Column A and clinic IDs will display in Column B.
2. Complete the worksheet by entering the following information for each clinic:
• Method Used for Data Collection (Column C): Enter the appropriate code for each clinic ID.
1 = EMR: All data pulled via query
2 = Manual: Paper records only
3 = Manual: EMR and paper record
4 = EMR: Some data looked up manually
5 = EMR: All data looked up manually
• REL Data Collection (Columns D – G): Indicate if collection of race, Hispanic ethnicity,
preferred language and country of origin occurred using best practice methods. Best
practice methods include:
o Race: Self-Report: Allowing patient to self-report their race and Hispanic ethnicity.
o Race: Reporting Multiple Races: NOT using a multi-racial category, allowing patients to
select more than one race AND using a system that allows the collection and reporting
of more than one race for each patient.
o Language: Self-Report: Allowing patient to self-report preferred language.
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o Country: Self-Report: Allowing patient to self-report country of origin.
For each clinic ID indicate if best practices are used by using the following:
1 = Yes, we follow the best practice.
0 = No, we do not follow the best practice.
o Column D: Enter the appropriate code (1 or 0) to indicate if patients are allowed to
self-report race and Hispanic ethnicity.
o Column E: Enter the appropriate code (1 or 0) to indicate if clinic is NOT using a
multi-racial category, allowing patients to select more than one race AND using a
system that allows the collection and reporting of more than one race for each
patient.
o Column F: Enter the appropriate code (1 or 0) to indicate if patients are allowed to
self-report preferred language.
o Column G: Enter the appropriate code (1 or 0) to indicate if patients are allowed to
self-report country of origin.
• Not Reporting (Column H): Please indicate if a clinic is not reporting any data for this cycle
of data collection by entering the following code.
0 = Clinic is reporting
1 = Clinic is NOT reporting
o Please be advised MNCM’s policy requires clinic sites within a medical group to
submit their data through the DDS process. Likewise, that is a condition of
participation in pay-for-performance programs.
• Reason not reporting (Column I): Provide a reason that the clinic is not reporting (e.g., no
patients meet eligibility criteria).
3. Save the Excel file as a CSV file (see Section III - A for more information). Click Browse to search
and find the CSV file and then click Submit File.
Step 2: Review & Save
Verify the numbers entered by reviewing all of the clinic site’s information for accuracy (no typos or
duplicate patients). Click Save and Continue, or click Back to Step 1 to make corrections.
Step 3: Upload Data
Click Browse to search for the CSV file and click Upload CSV and Continue. The MNCM Data Portal will
scan the CSV file to identify possible errors. The Data Portal will then provide an upload status that will
indicate if there are errors or warnings in the data file. Click on the Refresh link to view an updated
upload status. To view errors and warnings, click View Errors & Warnings. If there are errors, the data
file will need to be corrected and resubmitted to the MNCM Data Portal. Refer to the Data Elements and
Field Specifications to review the required data specifications for each column.
1. Errors: Corrections must be made and a corrected file uploaded (e.g., date of birth is out-ofrange). Proceed to instructions below.
2. Warnings: Closely review these possible errors and decide whether corrections are needed. If
corrections to the data file are necessary, proceed to instructions below. If corrections are not
necessary, click Continue to Step 4.
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If corrections to the data file are necessary, make corrections in the original Excel file and save the
corrected file. Then save as a new CSV file to upload. Do NOT make corrections in the CSV file as this will
alter the data.
•

To re-enter the data collection method and/or REL Best Practice status and upload the corrected
file starting from Step 1: Enter Denominator click Clear & Start Over. Note: Completion of Steps
1, 2 and 3 will be necessary if Clear & Start Over is clicked.

•

If corrections are only needed to the data file click Re-Upload Data (csv) file. Begin with Step 3:
Upload Data.

Once the Data (CSV) File has been successfully uploaded to the Data Portal, click Continue to Step 4.
Step 4: Review & Submit
Review the quality checks for each item listed in the Data Elements and Field Specifications table as well
as the preliminary results and their comparison to the previous measure period’s results to determine if
there are errors in the data.
• To resubmit the data file only, click Re-Upload Data (CSV) File.
• To resubmit the data collection method and/or REL Best Practice status and the data file, click
Clear & Start Over at the bottom of the page.
Again, make corrections in the original Excel file and save the corrected file with a new name. Then
save as a new CSV file to upload. Do NOT make corrections in the CSV file as this will alter the data.
Once the data has been successfully submitted, review and check each box of the Pre-Submission
Quality Checklist. Click Continue. The page will be refreshed.
Data Comparison Notes
MNCM requests medical groups review the preliminary results for accuracy.
1. Review the following results:
• Number of Procedures Performed – The number of procedures included in the current and
previous submission.
• Rates – Measure results for the current and previous submission.
2. Compare the group results (population and results) to the prior submission.
Using the text box provided, describe reasons for any substantial changes. This is a required field.
Comments in this field inform MNCM about reasons for the changes and avoids additional follow-up.
After the text box is completed, click Save Notes.
If additional time is needed for review, click Save as Draft. To access the submission again, click on Data
Submission under the Spine Surgery - Lumbar Discectomy/Laminotomy section on the Home tab.
Contact support@mncm.org for assistance.
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NOTE: If this is the first data submission for this measure or if there have been substantial changes to
the measure itself, the Data Comparison Notes text box will not display.
When the data is ready to submit to MNCM: Click Submit Data to MNCM and proceed to Step 5: Done.
The Submit Data to MNCM button will not appear until the Pre-Submission Quality Checklist and Data
Comparison Notes steps have been completed as stated above.
Step 5: Done
The data file has been successfully submitted. The MNCM Data Portal will generate an e-mail confirming
receipt.
To download a report of patient level numerator compliance information, click Download Data near the
top of the data comparison section. Columns on the far right of the report indicate the patient’s change
in assessment scores between their preoperative and postoperative evaluations.
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Section IV: Data Validation

After data is submitted, MNCM completes the following validation of the preliminary results to ensure
accuracy and comparability.
Quality Checks
MNCM completes quality checks of the submitted data. If errors are identified, the medical group must
make corrections to the data file and resubmit.
Validation Audit
All medical groups are subject to an audit. Medical groups selected for an audit are contacted by MNCM.
A list of records for audit will be provided. Other audit preparations:
• The medical group or clinic site representative must be available to participate in the entire
audit process.
o For data that resides in an electronic record, the audit will be conducted via a HIPAA
secure, online meeting service; the medical group or clinic representative will need to
retrieve and display the selected records and screens necessary to complete the audit.
o For data that resides in a paper record, the audit will take place onsite.
• Patient names or other personal information may be blinded. MNCM will verify the date of
birth.
• The following items must be available for the audit:
o ALL requested patient records.
o The “crosswalk” between the unique patient identifier and the patient’s name and date
of birth, as necessary.
o Data collection forms and other notes describing where various data elements were
located in the patient record.
o List of patients that were excluded.
NCQA 8 and 30 Audit Process
MNCM utilizes the National Committee for Quality Assurance (NCQA) “8 and 30” process for audits.
• MNCM randomly selects 33 records from each applicable clinic site for validation. At most, 30
records for each clinic site will be reviewed. The additional three records are oversamples to
ensure 30 records will be available on the day of the review.
• The MNCM auditor reviews records one through eight in the sample to verify whether the
submitted data matches the source data in the medical record.
• If no errors are found in these eight records, the compliance rate is 100 percent, and the clinic
site is determined to be in high compliance. The MNCM auditor may determine no further
record review is necessary. The MNCM auditor communicates results to MNCM staff.
• If the auditor identifies one or more errors in these eight records, the auditor will continue
auditing records nine through 30 and a compliance rate is calculated (e.g., 27/30 records
compliant, 90 percent). If the compliance rate is less than 90 percent, the auditor will
communicate the results with MNCM, who will contact the medical group to discuss a corrective
action.
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Two-Week Medical Group Review of the Preliminary Statewide Results
The two-week medical group review is the medical group’s official opportunity to review and comment
on the preliminary statewide results. MNCM will provide a file of the results to all participating medical
groups. Each medical group is responsible for reviewing their own results, investigating any concerns,
and submitting evidence to MNCM if a change in results is requested. MNCM staff will review all
requests and determine an appropriate course of action. A notification about this review will be sent to
the primary data contact and other key contacts registered by the medical group in the MNCM Data
Portal.
After Validation
After MNCM validation is completed, MNCM will approve the data in the MNCM Data Portal. An e-mail
will be sent to the medical group’s data contact notifying them that the data was approved.
After all statewide results are approved, MNCM may publish clinic and medical group level results on
MNHealthScores.org. Results can also be found on the MNCM Data Portal > Results tab.
Medical groups should maintain data submission files and other documents related to data submission
for two years.
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Appendices
Appendix A: About Direct Data Submission
The goal of Direct Data Submission (DDS) is to collect patient-level data from medical groups on specific health
care conditions and publicly report comparable results of health care quality at the clinic site and/or medical
group level. All medical groups follow the same instructions for eligible population identification and data
collection. MNCM certifies methodologies prior to data collection. Then each medical group submits data to
MNCM via a secure, online data portal. As an independent auditor and as a service to each medical group,
MNCM validates the data for accuracy, calculates results from the validated data, and publicly reports the data
on MNHealthScores.org.

Required Reporting
DDS fulfills participation requirements for the Minnesota Department of Health’s Minnesota Statewide Quality
Reporting and Measurement System (SQRMS) as well as other health plan pay-for-performance programs. In
addition, DDS results can be used by medical groups for quality improvement purposes.

DDS Terms and Conditions
To participate in the DDS process, medical groups must agree to:
• MNCM’s DDS Terms and Conditions (signed electronically on the MNCM Data Portal).
• Complete a Business Associate Agreement with MNCM (signed electronically on the MNCM Data Portal).
• Submit a patient-level file to the secure MNCM Data Portal that automatically calculates results.
• Participate in the data validation process as required by MNCM.
• Have results publicly reported on MNHealthScores.org and in other reports.
• Submit data for ALL clinic sites.
• Submit data in required format (CSV).
• Submit data in good faith.
• Adhere to and follow all data submission timelines and formatting specifications.
Medical groups also understand that:
• MNCM works with corresponding health plans to determine Primary payer type (Commercial/Private,
Medicaid, Medicare, uninsured/self/pay) on your behalf to reduce burden.
• Most Minnesota health plans only accept results generated from the DDS method for their incentive
programs, because the patient-level results can be validated.
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Compliance with Federal and State Regulations
Our legal counsel has assured us that the DDS method complies with applicable provisions of the Health
Insurance Portability and Accountability Act (HIPAA), Health Information Technology for Economic and Clinical
Health (HITECH) Act, and Minnesota statute as long as we are acting as a business associate to each participating
medical group (e.g., by gathering and submitting data on its behalf) and have a signed BAA with the medical
group. The BAA is signed electronically on the MNCM Data Portal. The BAA is signed once and remains in effect
for all DDS measures.

Health Insurance Portability and Accountability Act Law:
•

The activities of data collection, data submission, public reporting and use of results for quality
improvement are considered within the scope of health care operations associated with the medical
group quality improvement efforts.

•

The federal HIPAA law specifically allows release of individually identifiable health information - without
the consent or authorization of the individual - for treatment, payment and health care operations of, or
for, the provider.

•

MNCM’s business associate agreement includes all provisions required by the HITECH Act.

Minnesota Statute:
•

The primary governing Minnesota statute is MN Stat. Section 144.335.

•

Subd. 3a. entitled "Patient consent to release of records; liability" states: (a) A provider, or a person who
receives health records from a provider, may not release a patient's health records to a person without
a signed and dated consent from the patient or the patient's legally authorized representative
authorizing the release, unless the release is specifically authorized by law.

•

However, the statute does not restrict release (without patient authorization) to only those
circumstances authorized by state law – the statute also applies to a release authorized by federal law.

•

Legal counsel assures us that it is reasonable to conclude that the HIPAA privacy regulation does
specifically authorize the release of such information. A covered entity is authorized by HIPAA to release
patient information for, among other things, health care operations and to its business associate that is
providing such health care operations on its behalf. As stated above, the services MNCM is engaged in
with providers falls within the scope of health care operations, and MNCM is acting as a business
associate to the medical groups when performing the services discussed above.

Helpline: 612-746-4522 | E-mail: support@mncm.org | MNCM Data Portal: https://data.mncm.org/login
© MN Community Measurement, 2017. All rights reserved.
46

2018 Spine Surgery:
Lumbar Discectomy/Laminotomy
Appendices

Appendix B: About MN Community Measurement
Mission and Vision:
The mission of MN Community Measurement is to accelerate the improvement of health by publicly reporting
health care information. Our vision is that MN Community Measurement will:
• Be the primary trusted source for health data sharing and measurement;
• Drive change that improves health, patient experience, cost and equity of care for everyone in our
community;
• Be a resource used by providers and patients to improve care; and,
•

Partner with others to use our information to catalyze significant improvements in health.
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Appendix C: Facility Codes
The tables below only include facilities within the state of Minnesota. The tables are not all inclusive. If the
hospital or freestanding outpatient surgical center where the procedure was performed does not have an ID
number assigned below, enter a code of “999” for Other and complete the free text field Facility Other
Description.
Table 1: Hospital Facility Codes

51 Abbott Northwestern Hospital
206 Appleton Area Health Services
172 Avera Marshall Regional Medical
Center
201 Avera Tyler Hospital
104 Bigfork Valley Hospital
211 Buffalo Hospital
213 Cambridge Medical Center
565 Cass Lake IHS Hospital
276 CentraCare Health - Long Prairie
281 CentraCare Health - Melrose
294 CentraCare Health - Monticello
110 CentraCare Health - Paynesville
149 CentraCare Health - Sauk Centre
159 CHI LakeWood Health Center
134 CHI St. Francis Health
136 CHI St. Gabriel's Hospital
140 CHI St. Joseph's Health
38 Children's | Minnesota
217 Chippewa County-Montevideo
Hospital
224 Community Memorial Hospital
229 Cook Hospital & Care Center
231 Cuyuna Regional Medical Center
117 District One Hospital
234 Douglas County Hospital
237 Ely Bloomenson Community Hospital
203 Essentia Health - Ada
225 Essentia Health - Deer River
290 Essentia Health - Duluth
246 Essentia Health - Fosston
261 Essentia Health - Holy Trinity Hospital
(Graceville)
175 Essentia Health - Northern Pines
(Aurora)
124 Essentia Health - Sandstone
142 Essentia Health - St. Joseph's Medical
Center (Brainerd)
148 Essentia Health - St. Mary's Medical
Center (Duluth)
167 Essentia Health - Virginia
147 Essentia Health St. Mary's - Detroit
Lakes
186 Fairview Lakes Medical Center
241 Fairview Northland Medical Center
285 Fairview Range

44
41
267
42
250
251
264
253
258
22
262
266
269
271
272
3
161
121
277
278
279
32
100
215
239
270
561
114
138
130
171
170
145

Fairview Ridges Hospital
Fairview Southdale Hospital
FirstLight Health System
Gillette Children's Specialty
Healthcare
Glacial Ridge Health System
Glencoe Regional Health Services
Grand Itasca Clinic and Hospital
Granite Falls Municipal Hospital &
Manor
Hendricks Community Hospital
Association
Hennepin County Medical Center
Hutchinson Health
Johnson Memorial Health Services
Kittson Memorial Healthcare Center
Lake Region Healthcare
Lake View Hospital
Lakeview Hospital
Lakewood Health System
LifeCare Medical Center
Madelia Community Hospital & Clinic
Madison Hospital
Mahnomen Health Center
Maple Grove Hospital
Mayo Clinic Health System in Albert
Lea & Austin
Mayo Clinic Health System in Cannon
Falls
Mayo Clinic Health System in
Fairmont
Mayo Clinic Health System in Lake
City
Mayo Clinic Health System in
Mankato
Mayo Clinic Health System in New
Prague
Mayo Clinic Health System in Red
Wing
Mayo Clinic Health System in
Springfield
Mayo Clinic Health System in St.
James
Mayo Clinic Health System in Waseca
Mayo Clinic Hospital, Saint Mary's
Campus and Methodist Campus

280 Meeker Memorial Hospital
2
Mercy Hospital (Coon Rapids)
283 Mercy Hospital (Moose Lake)
4
Mercy Hospital - Unity Campus
228 Mille Lacs Health System
24003F Minneapolis VA Health Care
System
292 Minnesota Valley Health Center
299 Murray County Medical Center
127 New Ulm Medical Center
30 North Memorial Medical Center
230 North Shore Health
169 North Valley Health Center
105 Northfield Hospital
107 Olmsted Medical Center
108 Ortonville Area Health Services
257 Owatonna Hospital
26 Park Nicollet Methodist Hospital
112 Perham Health
33 Phillips Eye Institute
113 Pipestone County Medical Center
Avera
254 Prairie Ridge Hospital and Health
Services
245 Rainy Lake Medical Center
116 RC Hospital & Clinics
240206 Red Lake IHS Hospital
296 Redwood Area Hospital
12 Regina Hospital
11 Regions Hospital
118 Rice Memorial Hospital
6
Ridgeview Medical Center
207 Ridgeview Sibley Medical Center
222 River's Edge Hospital & Clinic
119 RiverView Health
204 Riverwood Healthcare Center
133 Saint Elizabeth's Medical Center
219 Sanford Bagley Medical Center
102 Sanford Bemidji Medical Center
214 Sanford Canby Medical Center
265 Sanford Jackson Medical Center
221 Sanford Luverne Medical Center
106 Sanford Thief River Falls Medical
Center
156 Sanford Tracy Medical Center
235 Sanford Westbrook Medical Center
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174 Sanford Wheaton Medical Center
177 Sanford Worthington Medical Center
8
Shriners Hospitals for Children - Twin
Cities
129 Sleepy Eye Medical Center
367 St. Cloud Hospital
24002F St. Cloud VA Health Care System

7
21
13
143
152
153
157

St. Francis Regional Medical Center
St. John's Hospital
St. Joseph's Hospital
St. Luke's Hospital
Stevens Community Medical Center
Swift County-Benson Health Services
Tri-County Health Care

Table 2: Freestanding Outpatient Surgical Centers
64
53
18
50
11
31
5
61
21
49
9
17
19
52
54
69
3
22
7
13
10
43
48

Allina Health - Abbott Northwestern WestHealth
Allina Health - University Avenue Surgery Center
Brainerd Lakes Surgery Center
CDI Twin Cities ASC
Centennial Lakes Surgery Center
CentraCare Surgery Center, Saint Cloud
Central Minnesota Surgical Center
Chaska Plaza Surgery Center, LLC
Children's - Minnetonka
Chu Surgery Center
Crossroads Surgery Center
Crosstown Surgery Center
Edina Surgery Center, Inc
Fairview Maple Grove Surgery Center
Family Surgery Center LLC
Greenway Surgery Center
High Pointe Surgery Center
Institute for Low Back and Neck Care, Special Procedures
Lakewood Surgery Center
Landmark Surgery Center
Mankato Surgery Center
Maplewood Surgery Center
Midsota Surgical Suites

47
42
41
40
38
4
29
67
39
15
62
26
23
32
70
71
30
6
14

52
162
19
176
227
14

United Hospital
United Hospital District
University of Minnesota Health
Windom Area Hospital
Winona Health Services
Woodwinds Health Campus

Midwest Surgery Center
Minnesota Orthopaedic Surgery Center LLC
Minnesota Surgery Center, Ltd - Edina
Minnesota Surgery Center, Ltd - Maple Grove
Minnesota Valley Surgery Center, LLC
North Memorial Ambulatory Surgery Center at Maple
Grove
North Metro Surgery Center
Pain Centers of Minnesota-Mankato
Pavilion Surgery Center, LLC
Saint Cloud Surgical Center
Sanford Health Detroit Lakes Clinic Same Day Surgery
Center
South Central Surgical Center
Southwest Minnesota Surgical Center, Inc.
Southwest Surgical Center dba Orthopaedic Institute
Surgery Center
Summit Orthopedics - Plymouth Surgery Center
Summit Orthopedics - Vadnais Heights Surgery Center
TRIA Orthopaedic Center, LLC
Willmar Surgery Center
Woodbury Ambulatory Surgery Center
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Appendix D: Patient Reported Outcome (PRO) Tools
The most important step in measuring the change in functional status and quality of life for patients is to
implement the administration of the PRO tools into your clinic’s processes and work flows. PRO tools
need to be integrated into the preoperative evaluation and postoperative follow-up at three months.
There are three PRO tools used to calculate the outcomes for the patient:
•
•
•

Oswestry Disability Index (ODI), a low back pain specific assessment tool.
PROMIS Global Health 10, a quality of life assessment tool.
VAS Visual Analog Pain scale.

Additional Information about PRO Tools
Ideally tools are completed by the patient at the time of the preoperative and postoperative visits;
however office visits are not required for tool completion. Any provider or office staff may administer
the pre and postoperative assessment tools.
PRO Patient Reported Outcome Tools- Modes of acceptable administration
Administration Mode
ODI
VAS Pain
PROMIS-10
In person/during visit
Acceptable
Acceptable
Acceptable
Via mail
Acceptable
Acceptable
Acceptable
Via telephone
Acceptable
Not Acceptable*
Acceptable
Administer electronically **
Acceptable
Acceptable
Acceptable
*Tools that have a visual analog component cannot be administered reliably by phone interview.
**When administering electronically, the tool must be kept intact including content, order and scoring.
Electronic examples: Email, patient portal, iPad/tablet, patient kiosk.
Other Activities
ODI
VAS Pain
PROMIS-10
Store results in EMR
Acceptable
Acceptable
Acceptable
Must seek approval for other uses*
Yes
No
Yes
* examples: research, publication, use of tool beyond measure population, etc.
NOTE: All patients who meet eligible population criteria must be included in the data submission file,
whether or not they completed the Patient Reported Outcome tools.
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Oswestry Disability Index (ODI) version 2.1a
This is a patient completed survey consisting of 10 structured questions asking the patient to describe
the impact of their low back pain and function in the following areas: pain, personal care, lifting,
walking, sitting, standing, sleeping, sex life (if applicable), social life, and ability to travel. More
information can be found at
http://www.proqolid.org/instruments/oswestry_disability_index_odi?fromSearch=yes&text=yes.
•

•

If a question was skipped, leave that question blank. Do not fill blanks with a zero as this is a
valid response in the tool.
o If submitting the summary score only, do not submit the score if less than eight
questions are answered.
If a patient selects more than one response to a question, submit the highest (worst) response.
If submitting a summary score only, use the highest (worst) response in creating the summary
score.

There are two options for submitting ODI assessment information to MNCM.

Option # 1: Submit the Summary ODI score only
If the summary ODI score is submitted the patient must complete at least eight out of10 questions
asked. The Summary ODI score CANNOT be submitted if the patient answers seven or less questions.
Please refer to developer’s scoring table in this appendix. The following is an example of calculating the
percent score according to the following rules:
1. Score each section of the ODI (0 to 5).
2. If less than 8 questions are answered, DO NOT include the score.
3. Add up the score of section.
4. Double the score, for example 40.
a. If all 10 questions answered in this example the patient’s Summary ODI score would be
40.
b. If 9 questions answered, patient’s % ODI would be 44.
c. If 8 questions answered, patient’s % ODI would be 50.
5. Submit the correct summary score for this patient.
Medical groups who elect to submit the summary score alone must demonstrate during the presubmission data certification process that they calculate thescore accurately.

Option # 2: Submit each individual value
The MNCM Data Portal will evaluate all incoming responses, if eight of the 10 questions are completed
by the patient, the assessment tool can be used and the MNCM Data Portal will score appropriately. The
MNCM Data Portal will score appropriately, recalculating the denominator as recommended by the
developer, Jeremy Fairbank.
Helpline: 612-746-4522 | E-mail: support@mncm.org | MNCM Data Portal: https://data.mncm.org/login
© MN Community Measurement, 2017. All rights reserved.
51

2018 Spine Surgery:
Lumbar Discectomy/Laminotomy
Appendices
References
ODI © Jeremy Fairbank, 1980. All Rights Reserved. ODI - United States/English - Version of 29 Jul 11 Mapi Institute. ID6287/ODI_AU2.1a_eng-US.doc
Fairbank J, Pynsent PB. The Oswestry Disability Index. Spine 2000; 25(22):2940-2953
Baker DJ, Pynsent PB and Fairbank JCT (1989) The Oswestry Disability revisited. In Roland Jenner JR (eds)
Back pain: New approaches to rehabilitation and education. Manchester University Press.pp174-186
Fairbank JCT, Couper J, Davies JB, O’Brien JP. The Oswestry Low Back Pain Disability Questionnaire.
Physiotherapy. 1980;66:271-273

Permissions
Permission was granted to MNCM for the use of ODI version 2.1a and to post this tool on the MNCM
Data Portal for use by individual clinical practices for the purposes of participating in the state-wide
quality reporting and improvement effort. This tool is available in the public domain and is free of
charge for individual clinician use in clinical practice.
For medical groups who additionally intend to use the ODI for research, please refer to the MAPI Trust
website for more direction:
http://www.proqolid.org/instruments/oswestry_disability_index_odi?fromSearch=yes&text=yes
The tool developer, Dr. Jeremy Fairbank has stipulated that as a part of the user agreement that “For all
new studies, version 2.1a of the ODI must be used.” Version 2.1a is available for medical groups to use
and can be accessed on the MNCM Data Portal RESOURCES tab by selecting “Spinal Surgery” from the
drop-down menu.
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Interpreting the ODI Score
0 to 20%
21 to 40%
41 to 60%
61 to 80%
81 to 100%

minimal disability
moderate disability
severe disability
crippled
bed bound or exaggerative

Scandinavian Journal of Surgery 91: 208–211, 2002
Niskanen et al. The Oswestry Low Back Pain Disability
Questionnaire a Two Year Follow-up of Spine Surgery
Patients
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PROMIS Global Health ‐ 10
PROMIS Global Health 10‐ a patient completed assessment of health related quality of life consisting of
10 structured questions reported on two subscales: general physical health and general mental health.
NIH sponsored tool publicly available, free of charge, with multiple modes of administration available.
In using the PROMIS-10 for reporting outcomes, it is strongly recommended by the developer of the tool
that:
1. A summary score is not used and that the results are reported by its two subscales reflecting
global physical health and global mental health; and
2. The metric used for comparison is conversion to a T-score and reported as a change in T-score.
T-Score distributions are standardized such that a 50 represents the average (mean) for the US
general population, and the standard deviation around that mean is 10 points. A high score
always represents more of the concept being measured. Thus, a person who has T-scores of 60
for the Global Physical Health or Global Mental Health scales is one standard deviation better
(more healthy) than the general population.
For more information, access the PROMIS website: http://www.nihpromis.org/default.
Given the need to correctly calculate outcomes for the subscale measures and convert the results to the
appropriate T-score metric, medical groups must submit the corresponding number to each of the
patient’s response for all questions.
If the patient selects more than one response for a PROMIS-10 question; submit a blank for the value for
that question.
Versions of the PROMIS Global Health-10 (PROMIS-10)
MNCM has a license agreement with PROMIS Health Organization (PHO) to provide a pdf version of the
tool to providers on the MNCM data portal. On an annual basis, MNCM reviews the PHO website to
determine if there has been a version change. Version v1.1 is the version that has been in place since
the 2013 transition to PROMIS-10. In August 2016, a minor version v1.2 was published. PHO indicates
that a decimal change in a version reflects only a minor change, and this is the case for v1.2. The only
changes in this version upgrade were related to the numeric scaling of questions 8 and 10. There were
no changes in the context, wording of questions or order of questions. Granted, this changing of the
numeric scale removes the need for conversion of responses for Q8 and Q10 to allow for scoring, but
the MNCM Data Portal already does this conversion on file upload. It would be disruptive and
burdensome to practices to implement a new tool based on this minor change that does not impact the
psychometric properties of the tool. MNCM has decided to postpone upgrading to a new version of the
tool until there are substantial changes (e.g. wording of questions or contextual instructions for the
patient) that threaten comparability.
Note: Review of PROMIS Global Health instruments in August 2017 demonstrate no additional version
and therefore no needed change related to version.
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Therefore, medical groups should continue to utilize PROMIS-10 v1.1, available on the MNCM Data
Portal Resources Tab, until further notice.
In the future, with a substantive change in tool that necessitates a new version, medical groups will
receive advance notice of a version change and the tool will be provided on the MNCM Data Portal.

References
Hays, R. D., Bjorner, J. B., Revicki, D. A., Spritzer, K. L., & Cella, D. (2009). Development of physical and
mental health summary scores from the patient-reported outcomes measurement information system
(PROMIS) global items. Quality of Life Research, 18(7), 873-880.

Permissions
Permission was granted to MNCM for the use of the PROMIS Global Health- 10 in individual clinical
practice for the purposes of participating in the state-wide quality reporting and improvement effort. If
any medical group or practice plan to use results from the PROMIS-10 tool for other purposes or other
populations (i.e., research study and publication), it is recommended that an additional user agreement
with PROMIS Health Organization be obtained by the medical group that outlines its planned use.
Request form for instruments can be obtained at www.nihpromis.org/measures/instrumentdetails

Helpline: 612-746-4522 | E-mail: support@mncm.org | MNCM Data Portal: https://data.mncm.org/login
© MN Community Measurement, 2017. All rights reserved.
55

2018 Spine Surgery:
Lumbar Discectomy/Laminotomy
Appendices

Visual Analog Pain Scale
Visual Analog Pain scales are a method for assessing the patient’s level using a line to assess where the
patient is on the continuum of pain. There are numerous pain rating scales in use (public domain).
Principles that the work group felt were important:
1. Do not display the numeric values of the scale on the line that the patient is using to mark
where they are on the continuum, but selection needs to translate (behind the scenes) to a
numeric value for measurement.
2. Use the scale wording, “No Pain” on the left-hand (zero) side to “Intolerable” on the right-hand
(ten) side aligning with pain descriptions cited in research by Million et al.
3. Need to have two separate questions, one that asks about back pain and the second that asks
about leg pain.
This tool was created by MNCM based on the measure development workgroup’s principles. This tool is
available for groups to download and use from the MNCM Data Portal under the Resources Tab by
selecting “Spinal Surgery” from the drop-down menu. Groups are welcome to replicate this tool for use
including electronic administration, but must do so exactly.
Because this is a visual analog scale, the tool cannot be administered over the telephone.
If a patient selects more than one response to a question, submit the worst (higher numeric value)
response. If the patient selects a line between boxes, submit the value associated with the next highest
box. For example if the patient marks the line between 5.0 and 5.5, submit 5.5.
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Key for Numeric Translation
Do not include this in the portion of the tool for the patient to complete

References

Million R, Hall W, Nilsen KH, Baker RD, Jayson MI. Assessment of the progress of the back-pain patient
1981 Volvo Award in Clinical Science. Spine. 1982 May-Jun; 7(3):204-12.
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Appendix E: Prior Back Surgery Guidance
There are three categories of prior back surgery:
1. No prior back surgery in the lumbar region.
2. Prior back surgery in the lumbar region with fusion (with or without instrumentation).
3. Prior back surgery in the lumbar region without fusion (no instrumentation or bone graft
that fuses vertebrae).
Administrative claims data or CPT codes may or may not be useful in the identification of procedures to
indicate prior back surgery. The utilization of billing codes to identify procedures or complete field
specification elements requires consistent, accurate coding practices by the billing organization. The
value sets (CPT Hx Back Surgery w Fusion Value Set and CPT Hx Back Surgery No Fusion Value Set) are
provided for guidance purposes only. However, it may be more accurate to build this question into
documentation practices as separate discrete data fields as the patient may have had a prior back
surgery procedure performed by another medical group.
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Appendix F: Additional Measures
The following is a list of measures that will be calculated based on the data file submission of patients
meeting inclusion criteria. No additional calculations or submissions are required from the medical
groups.
MNCM Measure
Additional
Measures

Spine Surgery: Lumbar Discectomy/Laminotomy Direct Data Submission Measures
Outcome measures will provide information about functional status and quality of life
improvements following lumbar discectomy/laminotomy procedures.
Process measures provide an understanding about a medical group’s/ clinic’s adoption of the
functional status tools.
Additional Process Measures Include:
• Number of Lumbar Discectomy/ Laminotomy Procedures Performed During the
Measurement Period
• Number and % of lumbar discectomy/ laminotomy patients administered a preop
Oswestry Disability Index (within 3 months of proc)
• Number and % of lumbar discectomy/ laminotomy patients administered a preop VAS
Pain Tool for Back Pain (within 3 months of proc)
• Number and % of lumbar discectomy/ laminotomy patients administered a preop VAS
Pain Tool for Leg Pain (within 3 months of proc)
• Number and % of lumbar discectomy/ laminotomy patients administered a preop
PROMIS-10 (within 3 months of procedure)
• Number and % of lumbar discectomy/ laminotomy patients administered a three month
postoperative Oswestry Disability Index
• Number and % of lumbar discectomy/ laminotomy patients administered a three month
postoperative VAS Pain Tool for Back Pain
• Number and % of lumbar discectomy/ laminotomy patients administered a three month
postoperative VAS Pain Tool for Leg Pain
• Number and % of lumbar discectomy/ laminotomy patients administered a three month
postoperative PROMIS-10
• Number and % of lumbar discectomy/ laminotomy patients administered both a
preoperative and three month postoperative Oswestry Disability Index
• Number and % of lumbar discectomy/ laminotomy patients administered both a
preoperative and three month postoperative VAS Pain Tool for Back Pain
• Number and % of lumbar discectomy/ laminotomy patients administered both a
preoperative and three month postoperative VAS Pain Tool for Leg Pain
• Number and % of lumbar discectomy/ laminotomy patients administered both a
preoperative and three month postoperative PROMIS-10
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Appendix G: Glossary of Terms

Standard list of terms often used in the data submission process. Not all terms apply to all measures.
Allowable Exclusions: Allowable exclusions are optional. A medical group may choose to remove
patients from data submission who meet the criteria described in the Allowable Exclusions section of
the measure specifications.
Assignment: The process by which clinics are assigned to clinical quality measures, for which they are
then responsible to report data to MNCM. Assignments are based on specialties offered at each clinic.
These specialties are selected by the medical group during clinic registration.
Audit: The process by which MNCM reviews and validates the data submitted to ensure the data reflects
the patient record. Audits are completed on-site at a clinic or electronically.
Calculated Exclusions: Exclusions that are calculated by the MNCM Data Portal based on data supplied
in the data file. Patients to whom a calculated exclusion applies must still be included in the data file;
upon submission, the Data Portal will remove the appropriate patients from measure calculation.
Clinic: The individual practice site or sites that are registered under the main medical group. Clinics are
locations where primary or specialty care ambulatory services are provided for a fee by one or more
physicians.
A clinic site location is a building, separate space or an entity with a street address. It should be a
functional unit that is easily understood by patients/consumers. The goal of reporting by clinic site is to
provide patients/consumers with information about the entity with which they are most familiar and to
provide information to clinics that is actionable for quality improvement purposes.
Clinic and Provider Registration: The annual process by which clinics and providers register on the
MNCM Data Portal. Providers who worked at a clinic site during the previous calendar year must be
registered. Typically this occurs annually during December and January. Please see the Clinic and
Provider Registration Instructions for specific details and guidance.
Clinic ID: Assigned to a clinic by the MNCM Data Portal when the clinic first registers on the MNCM Data
Portal.
Clinical Staff: Defined, for the purposes of Clinic and Provider Registration, as the following provider
types: physicians (MD or DO), advanced practice registered nurses (e.g., Certified Nurse Practitioner,
Certified Nurse Specialist, and Certified Nurse Midwife) and physician assistants (PA).
Contacts Tab: Tab in the MNCM Data Portal that lists all contacts for a particular medical group. Medical
groups can add, remove or edit contact people on this tab. While changes can be made at any time, this
information must be updated by medical groups during Clinic and Provider Registration.
Crosswalk: Process by which a unique identifier is linked to a patient’s name and date of birth so
medical records can be located by clinic staff in the case of an audit by MNCM.
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CSV File: Acronym for “comma separated values.” A CSV file is a common and simple format that is used
to import/transport data between systems or software applications that are not directly related (e.g.,
from a spreadsheet to a database). All data submission files are formatted as CSV files.
Data Collection Form: Form that has all patient-level data elements necessary to collect for measure. It
is optional for medical groups to use this form. It may be most useful for clinics/medical groups using
paper records.
Data Collection Guides: Document providing instructions for clinics/medical groups to submit data
counts or files to the MNCM Data Portal.
Data Comparison: Part of DDS process where clinics/medical groups are asked to review the current
measurement period’s preliminary results for each clinic compared to the last data submission for this
measure and consider any changes between the current period and the prior period. It is expected that
an explanation will be entered into a text box to account for any changes or to indicate that the data
comparison is expected.
Data Elements: Components necessary to submit data files to MNCM and to calculate measure results.
Data File: Excel template supplied on the MNCM Data Portal for DDS data submission. Templates are
specific to and formatted correctly for each measure.
Data File Transfer Selection: MDH has requested the receipt of patient level data. Medical groups must
indicate on the MNCM Data Portal if they chose to allow MNCM to share patient-level data with MDH.
This is called Data File Transfer Selection. Detailed information about the Data File Transfer Selection
options can be found in Section I of the data collection guides.
Data Portal: Secure, HIPAA-compliant portal owned by MNCM where clinics/medical groups can submit
patient-level data to MNCM for validation and accurate calculation of results.
Data Quality Checks: MNCM recommends completing several internal quality checks of the data prior to
data file submission. Quality checks improve data accuracy, reduce the likelihood of errors and ensure
the data can be validated upon audit. Please refer to specific data collection guides for guidance on data
quality checks for each measure.
Denominator: The denominator is the bottom number in a fraction. In epidemiology, it represents a
population group at risk of a specific disease. In clinical quality measurement, it is the total number of
patients (or observations) included in the calculated score.
Direct Data Submission (DDS): The DDS method was developed by MNCM to allow medical groups to
submit patient-level data for verification of results. In this process, medical groups upload files of
patient-level clinical data and clinic results are automatically calculated by the MNCM Data Portal.
MNCM validates data submitted through the DDS process before results are publicly reported.
Electronic Medical Record: A digital version of a paper chart that contains all of a patient’s medical
history from one practice, which is also known as EMR or Electronic Health Record (EHR).
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Eligible Population: A group of patients who have met all eligibility criteria to be included in a measure.
EMR Reporting Rule: Established by MDH, clinics that had an EMR in place (at any stage) for the last two
measurement periods are required to submit data on their total population.
Errors: The error and warning report will be displayed after a patient-level data file is submitted via the
MNCM Data Portal. Errors are “hard stops” in the Data Portal (e.g., dates of birth in the file are outside
the date of birth range specified for a measure) that result in the submission of a file not being allowed.
They must be corrected and a revised patient level data file must be uploaded to the Data Portal before
submission can occur.
Excel Format: Format of Excel template columns necessary to submit data file to MNCM Data Portal.
Excel Template: See Data File.
Exclusions Template: Template available on the MNCM Data Portal for tracking excluded patients. This
document will need to be uploaded to the MNCM Data Portal when the clinical data file is submitted on
measures for which exclusions are tracked. MNCM will review this list and validate a selection of records
during the validation audit. Please read more about the Exclusions Template in Section III.
Field Specifications: The detailed section in the data collection guides that provides instructions and
guidance for the collection of required data elements for measure score calculation.
Final Results: Results calculated by the MNCM Data Portal after submission of a patient level data file
after validation is completed. Final results are displayed on MNHealthScores.org.
Full-Time Equivalent (FTE): The best reflection of the time the provider practiced in a typical work week
at each clinic site over the course of a calendar year. FTE information is submitted during Clinic and
Provider Registration in the provider registration step. Please see the Clinic and Provider Registration
Instructions guide for more information.
Group and Clinic Sites Tabs: These tabs display information about the medical group and clinic sites in
the MNCM Data Portal. Information can be edited for the group or clinic sites as needed.
Home Tab: This tab displays information about all the current measures and deadlines for which the
medical group is responsible.
Hospital-Based Outpatient Clinic Locations: These are included in the physician clinic definition and
must be registered and report required measures.
Inactive Patients: Patients designated as inactive in a practice management system, billing system or
electronic medical record must be included in the eligible population if they meet measure criteria.
Insurance Coverage Data Elements, Field Specifications and Codes: Document to be used in
conjunction with the data collection guides to accurately collect and report insurance coverage data
elements.
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Inter-Rater Reliability (IRR): Recommended to conduct several sample audits with all abstractors for
training purposes if more than one person will abstract data. This ensures measurement specifications
are interpreted consistently and data is collected uniformly.
Measure Logic/Flow Charts: Used to help illustrate the identification of the eligible population and the
logic of measure calculation.
Measure Specifications: Provide detailed information about each measure, including measure
description, methodology, measurement period, denominator, exclusions and numerator. Located in
the data collection guides that are available on MNCM.org and the MDH website.
Medical Group: The highest level of the MNCM Data Portal clinic and provider registration construct.
The medical group represents a single centralized organization that operates one or more clinic sites.
Organizations define the parameters of the medical group at the time of registration and may choose to
divide clinics operated by the organization into more than one medical group. Medical groups with only
one clinic site must enter information under both the medical group and clinic sections, even though the
information will be the same. When reporting on the clinical quality measures, data for all clinic sites is
submitted to MNCM in one file via the medical group.
Medical Group ID: Assigned to a medical group by MNCM when the medical group first registers on the
MNCM Data Portal.
Multi-Specialty Clinics: A clinic site that has multiple specialties located in one building (one street
address). Medical groups have the option to register a single clinic site or register each specialty as its
own clinic site and then also register a main clinic site. How clinics decide to register depends on how
the clinic desires to have their clinical measures publicly reported on MNHealthScores.org. Please review
the Clinic and Provider Registration Instructions guide for further information about registering multispecialty clinics.
National Provider Identifier (NPI): A unique identifier for individual providers or organizations that
render health care. Health care providers who are HIPAA-covered entities obtain an NPI to identify
themselves in HIPAA standard transactions. Also referred to as Provider ID.
Newly Opened/Acquired Clinics: If a medical group opened or acquired a new clinic in the last year, the
new clinic must be registered with the medical group and must submit data with the medical group. If
the new clinic uses a different practice management system, billing system or EMR, they should follow
the same instructions and measure specifications to collect the data, and the medical group should
include the new clinic’s data in the data submission to MNCM.
Number of Eligible Patients (Exclusions Removed): Number of patients who are eligible or met the
inclusion criteria for the measure with excluded patients removed for each clinic. This count should be
entered into the MNCM Data Portal during data submission.
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Number of Patients Submitting: Number of patients who are eligible and being submitted. This should
be the same number as the as Number of Eligible Patients (Exclusions Removed) if submitting total
population. If submitting a sample population, this is the number of patients in the sample population.
This number must match the number of patients in the data file.
Numerator: The numerator is the top number in a fraction. In epidemiology, it represents the number of
people in a population group who develop the disease of interest. In clinical quality measurement, it is
the number of patients that meet all specified targets of a measure.
Patient Attribution: A patient is attributed to one clinic and provider that are considered to be
responsible for managing the patient’s care. Please refer to specific data collection guides to review
patient attribution for each measure as it they differ.
Patient-Level Data: Data elements required to calculate measure results. Data is submitted to MNCM
Data Portal via a HIPAA-secure process.
Patient Registries: A tool used by some medical groups to track patient progress and for quality
improvement purposes. MNCM cautions the use of patient registry information for quality measures.
Many registries give a “snapshot” of patients at a given time and would therefore not include all
patients according to established patient criteria or may not reflect the most recent clinical data (e.g.,
most recent blood pressure or labs). Registries that are programmed to update the patient population
and clinical results on a continual basis (24/7) could possibly be used to create data file for submission;
however, please discuss this with MNCM before use. During the validation audit, the MNCM auditor will
use the patient record not the patient registry. If a clinic uses data from a patient registry, the auditor
may find a more recent date/value in the medical record and this would be counted as an error.
Pre-Submission Data Certification: This process is intended to help identify potential data issues prior to
file submission.
Pre-Submission Data Certification Form: Document medical groups complete to outline the method for
identifying the eligible population and other details pertinent to the validation of submitted data.
Preliminary Results: Results calculated by the MNCM Data Portal after submission of a data file but
before results are fully validated.
Primary Data Contact: The person from the medical group who uploads/submits data files for the
clinical quality measures; receives communications from MNCM about data submission and other
important updates; and completes the medical group’s annual registration of the clinics and clinical staff
on the MNCM Data Portal. It is important that the Primary Data Contact information for medical groups
remains up-to-date to ensure MNCM communication is received by the appropriate person in a timely
manner.
Provider File: Excel Template available on the MNCM Data Portal for Clinic and Provider Registration.
This document is uploaded to the MNCM Data Portal during registration.
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Provider ID: Created by medical group/clinic for providers who do not have an NPI. This ID will be used
in the data file submission to MNCM.
Provider Type: Medical Doctor (MD, including physicians who have medical degrees from other
countries such as MBBCH, MBBS, MBCHB); Doctor of Osteopathy (DO); Physician Assistant (PA) or
Advanced Practice Registered Nurse (e.g., Certified Nurse Practitioner, Certified Nurse Specialist,
Certified Nurse Midwife) are providers that are required to be registered during Clinic and Provider
Registration. Refer to the specific measure specifications for eligible provider types required to report
clinical data for each measure as they differ.
Provider Registration: See Clinic and Provider Registration.
Provider Specialty Code: Codes generated by MNCM to indicate the board certified specialty of
providers. The codes are included in the provider registration file and DDS data file. Please see the Clinic
and Provider Registration Instructions guide as well as each data collection guide for further guidance.
Providers Tab: This tab displays all of the information about providers submitted during Clinic and
Provider Registration.
REL: Acronym referring to data elements of race, Hispanic ethnicity, preferred language and country of
origin.
REL Best Practice: Data collection best practice methods for REL data elements include: allowing
patients to self-report race and Hispanic ethnicity, preferred language and country of origin as well as
NOT using a multi-racial category; allowing patients to select more than one race; and using a system
that allows the collection and reporting of more than one race for each patient. For more information
about collecting this data from patients, refer to the Handbook on the Collection of Race Ethnicity and
Language Data available on MNCM.org under Submitting Data > Training & Guidance > Data Collection
Guides.
REL Data Elements, Field Specifications and Codes: Document to be used in conjunction with the data
collection guides to accurately collect and report REL data elements.
Required Exclusions: This type of exclusion is required. A medical group must remove patients from
data submission who meet the criteria described in the Required Exclusions section of the Measure
Specifications. These exclusions have evidence that they are clinically appropriate or that the frequency
and impact of the inclusion of these patients would distort the calculated result.
Results Tab: This tab includes final data results and file downloads from prior submission cycles, as well
as charts of current and historical results.
Resources Tab: This tab is organized by topic or measure, and houses data submission guides, tools and
frequently asked questions by measure.
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Roll-up: Process by which multiple clinics report data under one clinic. Clinics can report clinic quality
data as one clinic if they meet all of the three following criteria: A) have common ownership; B) have a
majority (more than half) of common clinical staff working across the multiple locations (these clinical
staff must rotate between all of the clinic locations); and C) the total clinical staff across all locations is
no greater than 20 FTEs. Please see clinical staff for further details.
Sample Population: A random selection of patients to be submitted for clinical measures. The sample
population is drawn from the total eligible population. The minimum required sample is 60 patients per
clinic site. See the EMR Reporting Rule to determine eligibility for sample population submission. Not all
measures allow sample population submission. Please see data collection guides for more detailed
instructions.
Statewide Quality Reporting and Measurement System: State health reform law passed in 2008. Under
this law with specific directives within Minnesota Statutes, section 62U.02, all physician clinics are
required to register and submit data on measures to be publicly reported to the Commissioner of
Health. To implement physician clinic registration and the collection of quality measurement data, MDH
developed SQRMS, created through Minnesota Rules, Chapter 4654. MDH has contracted with MNCM
to assist with implementing SQRMS. Under this contract, MNCM supports physician clinics in meeting
registration and measure requirements
Summary of Changes: Area at the beginning of each data collection guide which highlights changes from
the previous year.
System Query: Process by which data elements are pulled from chart system (EMR or manual) by
clinics/medical groups.
Total Population: Consists of the entire eligible population. Please refer to the specific data collection
guides for further instructions on how to submit total population.
Two-Week Review Period: Period after data submission in which clinics/medical groups can review their
preliminary results in comparison with other clinics/medical groups. This is a very important validation
step to ensure accurate results before public reporting.
Urgent Care Clinics: A type of walk-in clinic, either stand-alone or offered as a service of a multispecialty clinic, that primarily treats illness or injuries requiring immediate care, but not serious enough
to require an ER visit. Stand-alone urgent care clinics must register and complete an annual Health
Information Technology (HIT) survey; however, urgent care clinics are not required to report on clinical
quality measures.
Value Set: A set of administrative codes used to define a concept related to the measure construct (e.g.
denominator, exclusions) using standard coding systems (e.g. ICD-10, CPT, LOINC).
Value Set Dictionary: A spreadsheet based list of codes by measure. Contains all Value Sets applicable to
a given measure.
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Warnings: The error and warning report is displayed in the MNCM Data Portal after data file submission.
Warnings should be reviewed to determine if corrections are needed.
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